
EzCad2UNI User’s Manual

I All rights reserved

SOF_CUB_EZCAD2UNI_V2(10)

EzCad2.10UNI
User’s Manual



EzCad2UNI User’s Manual

II All rights reserved

Contents
EzCad2.10UNI...................................................................................................................................I
User’s Manual.................................................................................................................................. I
Chapter1 Introduction......................................................................................................................1

1.1 EzCad2 Brief Introduction.................................................................................................... 1
1.1.1 Software Installation.................................................................................................. 1
1.1.2 Software Function...................................................................................................... 1
1.1.3 Interface Introduction.................................................................................................1

1.2 About EzCad2 User’s Manual...............................................................................................2
1.2.1 Contents Arrangement................................................................................................2
1.2.2 Announcement............................................................................................................3

Chapter 2 File Menu......................................................................................................................... 4
2.1 New (N).................................................................................................................................4
2.2 Open (O)................................................................................................................................5
2.3 Save (S) / Save As (A).......................................................................................................... 6
2.4 Import vector file,import bitmap file.................................................................................... 7
2.5 Print....................................................................................................................................... 8
2.6 Obtain Scan Images (M)....................................................................................................... 8
2.6 System Parameter (P)............................................................................................................9

2.6.1 General....................................................................................................................... 9
2.6.2 Color.........................................................................................................................10
2.6.3 Work Space...............................................................................................................11
2.6.4 Auto Save................................................................................................................. 11
2.6.5 Move-Rotate.............................................................................................................12
2.6.6 Plug Manager........................................................................................................... 12
2.6.7 User manager........................................................................................................... 13
2.6.8 Language.................................................................................................................. 13

2.7 Image Library......................................................................................................................14
2.8 Recent File List................................................................................................................... 14
2.9 Exit (X)................................................................................................................................14
2.10 Object List......................................................................................................................... 15
2.11 Object Properties............................................................................................................... 15

Chapter 3 Edit Menu...................................................................................................................... 17
3.1 Undo (U) / Redo (R)........................................................................................................... 17
3.2 Cut (T) / Copy (C) / Paste (P)............................................................................................. 17
3.3 Combine / Uncombine........................................................................................................ 18
3.4 Group / UnGroup................................................................................................................ 18
3.5 Hatch................................................................................................................................... 18
3.6 To Curve.............................................................................................................................. 24
3.7 To Dashed............................................................................................................................24
3.8 Offset................................................................................................................................... 25
3.9 UnGroup Text......................................................................................................................25

Chapter 4 Draw Menu.................................................................................................................... 25
4.1 Point (D)..............................................................................................................................26



EzCad2UNI User’s Manual

III All rights reserved

4.2 Curve................................................................................................................................... 26
4.3 Rectangle.............................................................................................................................27
4.4 Circle................................................................................................................................... 28
4.5 Ellipse..................................................................................................................................28
4.6 Polygon................................................................................................................................29
4.7 Text...................................................................................................................................... 29

4.7.1 Character Properties.................................................................................................30
4.7.2 Curve text function...................................................................................................31
4.7.3 Circle Text................................................................................................................ 35
4.7.4 Barcode Text............................................................................................................ 35
4.7.4 Variable Text.............................................................................................................41

4.8 Bitmap................................................................................................................................. 58
4.9 Vector File........................................................................................................................... 63
4.10 Time-lapser........................................................................................................................64
4.11 Input Port...........................................................................................................................64
4.12 Output Port........................................................................................................................ 64
4.13 Select................................................................................................................................. 65
4.14 Node Editing..................................................................................................................... 67
4.17 Encoder distance............................................................................................................... 69

Chapter 5 Modify Menu................................................................................................................. 71
5.1 Array....................................................................................................................................71
5.2 Transformation.................................................................................................................... 72

5.2.1 Move.........................................................................................................................73
5.2.2 Rotate....................................................................................................................... 73
5.2.3 Mirror....................................................................................................................... 73
5.2.4 Zoom........................................................................................................................ 74
5.2.5 Lean..........................................................................................................................75

5.3 Plastic.................................................................................................................................. 76
5.4 Distribution..........................................................................................................................76
5.5 Curve Editing...................................................................................................................... 77
5.6 Align.................................................................................................................................... 78
5.7 JSF font............................................................................................................................... 79
5.8 Rsort.................................................................................................................................... 85
5.9 Trim..................................................................................................................................... 85

Chapter 6 View Menu..................................................................................................................... 86
6.1 Zoom................................................................................................................................... 86
6.2 Ruler / Gridding / Guide Line.............................................................................................87
6.3 Snap Grid.............................................................................................................................87
6.4 Snap Guide Line..................................................................................................................87
6.5 Snap Objects........................................................................................................................87
6.6 System Toolbar / View Toolbar / Draw Toolbar / Status Bar / Object List Toolbar / Object
Properties Toolbar/ Mark Parameter Toolbar............................................................................87
6.7 IO state................................................................................................................................ 87

Chapter 7 Special.............................................................................................................................89



EzCad2UNI User’s Manual

IV All rights reserved

7.1 Change text..........................................................................................................................89
7.2 IPG Setting.......................................................................................................................... 89

Chapter 8 Laser............................................................................................................................... 91
8.1 Rotary marking....................................................................................................................91
8.2 Rotary marking 2.................................................................................................................94
8.10 MultiFileMark................................................................................................................... 95
8.4 Power Ruler.........................................................................................................................97
8.5 Ring Text Mark................................................................................................................. 103
8.6 Rotary mark.......................................................................................................................107
8.7 Rotate Text Mark...............................................................................................................109
8.8 Split mark 2....................................................................................................................... 109

Chapter 9 Help...............................................................................................................................117
9.1 About EzCad2....................................................................................................................117

Chapter 10 Marking......................................................................................................................118
10.1 Pen List............................................................................................................................118
10.2 Marking Parameter Base................................................................................................. 119
10.3 Mark-Control Bar............................................................................................................125
10.4 Machine Parameters........................................................................................................125

10.4.1 Field Parameter.................................................................................................... 125
10.4.2 Laser Control Parameter...................................................................................... 128
10.4.3 Port parameter...................................................................................................... 132
10.4.4 Other.....................................................................................................................134
10.4.5 HardInfo............................................................................................................... 138



EzCad2UNI User’s Manual

1 All rights reserved

Chapter1 Introduction

1.1 EzCad2 Brief Introduction

1.1.1 Software Installation
The EzCad2 software run on an PC with 900 MHz CPU and 256 MB RAM at least. In

general, we recommend the fastest PC available. EzCad2 was developed in Microsoft Windows
XP and will run in Windows XP ,WIN7,WIN8 and VISTA

The installation of EzCad2 is very easy. Users simply need to copy EzCad2 folder that is in
the Install CD to hard disk, and then double click the Ezcad2.exe under the EzCad2’s directory to
run the software.

EzCad2 requires a software security device sometimes known as a 'dongle'. This device
plugs into the USB port on the PC. If there is no dongle or the dongle do not install correctly, a
caution will appears and the software will work at demo state. In demo state, we can evaluate the
software but we cannot save files and cannot control laser device.
1.1.2 Software Function
Main functions of the software:
 Users can design their graphics freely.
 Various types of fonts are supported. Such as TrueType, SHX, JSF(Single line font defined

by EzCad2), DMF(Dot Matrix Font), One-Dimensional bar code, Two-Dimensional bar
code , and so on)

 Flexible variable text: changes the text real time while in laser processing. Excel datasheet is
supported.

 Can through the serial port direct read text data
 Can through the network direct read text data
 Strong node editing function make the curve modification more easier
 The software can support 265 “pencils”, which used to draw graphic and can be set different

processing parameters.
 Common types of images are supported. (bmp, jpg, gif, tga, png, tif…)
 Common vector images are supported. (ai, dxf, dst, plt…)
 Image processing (Grayscale, White / Black Transformations)
 Powerful hatching functions, such as support round hatch.
 More convenient IO operations and more easier to harmonize the auxiliary equipments.
 Supports the dynamic focus (3 axis processing system)
 Supports directly the SPI G3 fiber laser and the newest IPG_YLP and IPG_YLPM fiber laser
 An opening language supporting system makes it easy to run the software in various

languages platform.
1.1.3 Interface Introduction

 Software starting interface
The picture (Figure 1-1) appears while running the program, and meanwhile the initial

operations takes place in the background.
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Figure 1-1 Program starting interface

 Main Interface (Figure 1-2)

Figure 1-2 EzCad2 Main Window

1.2 About EzCad2 User’s Manual

1.2.1 Contents Arrangement

The User’s Manual will introduce each menu (File, Edit, Draw, Modify, View, Help) in turn.
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1.2.2 Announcement
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Chapter 2 File Menu

The File Menu is used for common file functions such as opening, saving, importing images
from Twain equipment, etc. (Figure 2-1)

Figure 2-1 File Menu

2.1 New (N)

“New" is used to create a blank work space to construct objects, and its shortcut key is “Ctrl
+ N”1. When “New” is clicked, the software will close the documents which you are editing and
meanwhile create a new file. If the documents you are working on have not been saved yet, the
software will prompt if you would like to save it.

The icon of “New” in toolbar is . Click on this icon will achieve the same operation.
If you move the mouse cursor onto the icon mentioned above and keep it for a while, a piece

of prompt information( Tooltip ) will appear, which briefly explains the function of this icon, and
also there will be some detailed explanations appearing in the status bar in the bottom of the main
window. And if you move the mouse cursor onto “New” in File Menu will only show detailed
explanations in the status bar.

1 “Ctrl + N” refers to press the key ‘N’ while press the key ‘Ctrl’. The following contents do the same.
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Reminder: In EzCad2 software, each icon in the Toolbar contains a function of showing
brief prompt information and displaying detailed explanation. Also, each icon has a corresponding
menuitem, and both the two ways carry out the same function. The User’s Manual will not
mention it again in the following chapters.

2.2 Open (O)

“Open” is used to load a saved “.ezd” file, and its shortcut key is “Ctrl + O”. (Figure 2-2)
When click “Open”, the software will pop an open-file dialog to ask you select the file you want
to open, See fig 2-2. When you select a valid “.ezd” file, the dialog would display the preview of
the file (you must have saved the preview when you save the file).

Figure 2-2 “Open” Dialog Box

The icon of “Open” in toolbar is .
The files saved with other file-format will not be opened by the “Open” command.
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2.3 Save (S) / Save As (A)

“Save” file is used to save the current state of a mark Document to disk. “Save As” is used to
write the current mark Document to disk by another name. Writing a file to its current name is the
same as the Save function.

Figure 2-3 “Save” dialog box

If the current Document has already been named, “Save” is selected to save it under the name
that was used to open the file, or the software will prompt to the user to choose a destination path
and type a name. Whether the current file is named or not, “Save As” will appear to ask for a new
name to save file, and the previous file will not be overwritten.

If you select “Save Preview Image”, you will see the preview when you open the file(refer to
“Open” function).

The icon of “Save” in toolbar is .
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2.4 Import vector file,import bitmap file
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2.5 Print

“Print” is used to print the images you are working with.

2.6 Obtain Scan Images (M)

“Scan Images” is used to get digital graphic object from Twain device. When selected the
“Scan Images” function will prompt the user to choose a Twain device. (The Twain device listed
in the column should be those which have been legally installed in the computer.) When the
suitable device is selected, you can now insert a graphic object into the currently selected
Document. (Different devices show different prompts. Please consult the devices operation
reference.)
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2.6 System Parameter (P)

“System Parameter” configures the software, and the icon of “System Parameter” in toolbar

is .

Users can use this command to change the default setting of Display, Save and Language, etc.
When selected, a dialog box will appear, and you can set the unit the software uses, the color

displayed, the work space’s parameter, the interval of auto save, the locale language, etc.
2.6.1 General

In “General”, common parameters can be configured. (Figure 2-5)
“Unit Type”: millimeter and inch are two options can be selected.
“Paste X” and “Paste Y”: the relative offsets to the previously object when paste.

“Grid”: show or hide the grid
“Grid Space”: adjust the distance in grid.
“ Enable Mark Mutex (EZCAD2MUTEX_MARKING) ” :This option is used to

synchronize the Ezcad program with third-party programs. If checked, the Ezcad software create a
mutex object named “EZCAD2MUTEX_MARKING”. The mark command cannot be executed
until the mutex is “signaled” by other programs. After marking, the mutex will be switched to
“nonsignaled” state by Ezcad software

“Execute when Ezcad starts”：The exe file appointed here will be executed when the
Ezcad software starts.

“Execute when Ezcad Finish”：The exe file appointed here will be executed when the
Ezcad software ends

Input IO mask: user could choose IO port through input IO mask, for example, if want to
use IO 0,1,2,3, you can click 0,1,2,3.

Output IO mask: user could choose IO port through output IO mask, for example, if want to
use IO 0,1, you can click 0,1.
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Figure 2-4 System Parameter

2.6.2 Color
“Color” is used to set the color of background, work space, guide line and grid, etc. Double

click the color stripe could change the color wanted. (Figure 2-5)
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Figure 2-5 Color Figure 2-6 Set the Work Space

2.6.3 Work Space

The set of the work space’s property contains setting the size, type and position at the work
space. (Figure 2-6)

The Work Space is the rectangle or circle area in the main interface window. This space is
corresponded with the available working field of the laser machine, and any object drawn in this
area will be marked in operation. Due to the limit of the field, those objects drawn out of this
space may not be marked.

2.6.4 Auto Save

“Auto Save” refers to the interval time between two automatic saves, and the initial value is
10 which means to save file per ten minutes. The file saved is named as ‘AutoSave.ezd’ in
EzCad2’s directory. (Figure 2-7)
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Figure 2-7 Auto Save Figure 2-8 Move-Rotate

2.6.5 Move-Rotate
See figure 2-8.

Nudge Distance: the distance that the object moved when pressing direction keys each time.

Big Nudge Scale: indicates the number the user wants to time the Nudge distance so as to
achieve further each time when synchronously press direction keys and “shift” key together

Rotate Angle: the angle the object rotates each time when press direction keys and “ctrl” key
together

Object’s Origin: when use “Put to origin” function, which point of the object should be put
on the origin.

2.6.6 Plug Manager

The list displays the EzCad software plug which has already been installed in the computer.
The users can activate or inactivate each plug. Press “blank” key or double click the plug name
will swtich the active state. (Figure 2-9) Changes will take effect in EzCad’s next start.
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Figure 2-9 Plug List

2.6.7 User manager
Uses in choosing whether to use the current software must to input the user password, as

shown in Figure 2-10
When enable “You must enter and password before

using”, the system default has a administrator and a
designer, the user can increase operator.

The jurisdiction of administrator is to use software
all functions

The jurisdiction of designer is to revise all software
function besides the user information

The jurisdiction of draftsman is to draw file, set
machine parameter, but can’t set user information,
system parameter and machine file.

The jurisdiction of operator is only could open
already completed document, cannot revise and preserve
the document, as well as revise the system parameter,
this may prevent the operator to change the system parameters to cause the equipment work by
mistake not to be normal.

After enter software with user, the file which name is log in will show in folder, with user
name and user entering time.
2.6.8 Language

This item is used to change languages between Chinese and English. (Figure 2-11)
Changes will take effect when restarting the marking software.

Figure 2-10 user manager dialog box
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2.7 Image Library

Save image in the lib,then take it out when wants to use.

2.8 Recent File List

Below the menuitem of System Parameter, a list is displayed to show the latest Document
files opened, and the max amount of the file items is ten. There is no file listed if users have never
opened / saved any “.ezd” files, and “Recent File” is unavailable.

2.9 Exit (X)

Exit the EzCad software. When selected the Exit function will prompt the user whether to
save the files which have not been saved yet.

Figure 2-11 Language
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2.10 Object List

Object List is in the left side of the main interface window.
Marked objects are grouped into an object structure or ungrouped to many objects. (Figure

2-12)
When in marking process, system will follow the order to mark the objects listed.
Users can rearrange the list by directly dragging the object up/down or right keyboard to

change the marking order.
Users can double click the object bar to name them.

Figure 2-12 Object List

2.11 Object Properties

Object Properties are displayed in the left side of the main interface window

 X position: the X coordinate of the
point in the left button corner of the
object selected.

 Y position: the Y coordinate of the
point in the left button corner of the
object selected

 Z position: the Z coordinate of
selected object

 X Size: width of the object selected
 Y Size: height of the object selected

 : Lock the current width/height

proportion of the object selected. If
user changes the object’s size, system Figure 2-13 Object Property
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will keep the X/Y ratio. Click the button will switch to unlock state

 : The coordinate data (X position, Y position) is maped to which point of the

object.
 Array: copy the current object and arrange them to the destination users want by setting

the row|column number and space
Count X: the count of the row
Count Y: the count of the column
Inc (mm): the space between each

row|column.
Figure 2-14 stands for the situation when
“X=3, Y=2”
Figure 2-15 stands for the situation when
“X=2, Y=3”

: set array’s row as marking precedence

: set array towards vertical direction as

marking precedence

: Unidirection marking.

: Bidirectional marking

Input port: The system reads the input port first,
and then compare whether the current input singal
is as the same as the object’s “I/O Control condition”, and if it does, the current object will be
marked, or, the system will skip the current object and handle next object. Only four bits (0, 1, 2, 3)
are available now. Each bit has three states. The grayed state means skip this signal. The
unchecked state means that if we want to mark this object then the signal of this bit must be low
level voltage (TTL compatible). The checked state stands for the high level voltage (TTL
compatible) needed.

: expect the high level voltage

: expect the low level voltage

: skip the signal

Figure 2-14 Array (X=3, Y=2)

Figure 2-15 Array (X=2, Y=3)

Figure 2-16 Input Port
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Chapter 3 Edit Menu

“Edit Menu” carries out the editing operation of an object. (Figure 3-1)

Figure 3-1 Edit Menu

3.1 Undo (U) / Redo (R)

“Undo” will undo the last action that the user made in EzCad2. For example, if the user
deleted an object accidentally, clicking Undo will bring the program back one step to where that
item still existed. And the user also can select “Redo” to redo the last action which has just been
deleted.

3.2 Cut (T) / Copy (C) / Paste (P)

“Cut” will delete the object selected from EzCad2 and copy it to the clipboard. It can be
inserted back into the .ezd file later using “Paste” function. Note that it will be lost if other data is
copied to the clipboard.

“Copy” will copy the selected object to the clipboard and reserve the current object.

“Paste” will paste the object from the clipboard to current document file.

The shortcut keys of “Cut”, “Copy” and “Paste” respectively are: Ctrl+X, Ctrl+C and Ctrl+V.
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3.3 Combine / Uncombine

“Combine” will ignore all the selected objects’ curve properties and combine those objects
into a new curve combination with new curve properties. Same as other objects, this new
combination can be selected, copied, pasted and set properties.

“Uncombine” will get the combination back to the curve objects separately. The objects after
“Uncombine” may be different from those before “Combine”. “Undo” should be used to restore
the original objects

The feature Combine’s icon in Toolbar is , and the feature Uncombine’s icon in Toolbar

is .

The shortcut keys of “Combine” and “Uncombine” respectively are: Ctrl+L and Ctrl+K.

3.4 Group / UnGroup

When selected the “Group” function will keep the selected objects’ original properties and
make them into a new object, and this new group, as the same as other object, can be selected,
copied, pasted and set object properties.

“Ungroup” will turn the object which has just been grouped into previous situation. The
object which has just been grouped by more than 1000 objects will become 10 objects. If the
object is a vector file which has different pen color, it will become some objects according to
color.

The icon of Group in Toolbar is , and UnGroup’s is .

The shortcut keys of “Group” and “UnGroup” respectively are: Ctrl+G and Ctrl+U.

3.5 Hatch

“Hatch” is used to force EzCad to calculate the hatch fills for the current objects. The object
to be filled must be closed curve, and if you choose many objects to fill, these figures can be
objects nested mutually. Any two objects may not have intersectant parts (Figure 3-2)
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Figure 3-2 Hatch

(Objects on the left can be filled; The two rectangles on the right may get unexpected result for they

intersect each other.)

The icon of Hatch in Toolbar is , and when selected a hatch dialog box will appear as Figure

3-3 shows.

Mark Contour: whether to show and mark the current object’s contour or not

means when click ‘Mark Contour’, mark hatch line first then mark contour

means when click ‘Mark Contour’,

mark contour first then mark hatch line
Hatch 1 / Hatch 2 / Hatch 3: Users may have

three independent hatch parameters to hatch the
same object at the same time. Each set of hatch
parameters can be appointed a Pen No. which
stands for a set of marking parameters.

Enable: whether to permit the validity of the
current hatch parameter.

All Calc: Calculate all the selected objects as
a whole. This is an optimizing option. In some
cases the speed of marking may highly be raised. It
will take long time to calculate large, complex
objects. When not selected, the objects will be
calculated separately.
For example: draw three rectangles, line distance is 1mm, angle is 0.
1. Do not click ‘All Calc’, system will mark as the order in object list, mark hatch line in the first

rectangle then mark hatch line in the second rectangle, and so on.
2. Click ‘All Calc’, mark all the hatch line at one time, mark all the hatch that on the same line.
3. Marking result as follow fig 3-4:

Figure 3-3 Hatch
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Fig 3-4(a) do not click ‘All Calc’, the hatch line are not in the same line

Fig 3-4(b) click ‘All Calc’, hatch line are in the same line
Type of Hatch: (Figure 3-5)

Unidirection hatch: The hatch lines will be marked from left to right.

Bidirectional hatch: The hatch lines will be marked from left to right first, and then

from right to left.

Ring-like hatch: fills objects from the outside to the inside like a ring

Optimization two-way hatch: similar with bidirectional hatch, but the end of each end connects.

Click the button will switch between the Unidirection, bidirectional, and ring-like hatch.
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Figure 3-5 Types of hatch

(The left object is being filled by Unidirection Hatch or Bidirectional Hatch, the middle object by

Ring-like hatch, and the right one is Optimization two-way Hatch)

Optimization Gong type hatch: similar with Gong, will jump in null place.

Gong type hatch Optimization Gong type hath

Above 5 types all can be changed by click the button , choose it according to different
application.

Angle: Hatch Angle stands for the angles between hatch lines and X axis, and Figure 3-6 is the
feature when the angle is 45 degrees.

Line Space: the space between two hatch lines
Edge offset: the distance between hatch lines and

the object’s outline (Figure 3-7)

Figure 3-6 Degrees
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Figure 3-7 Border Distance

(The left object shows the figure when Edge offset is 0 and the right shows when it is 0.5.)

Follow edge one time: draws outline one time around the hatch lines after filling (Figure
3-8)

Start Offset: the
distance between the first fill line and the border of the object

End Offset: the distance between the last fill line and the border of the object
Figure 3-9 shows the feature when it is filled.

Figure 3-8 Follow edge one

(The left object do not enable this option and the right one do.)
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Figure 3-9 Offset Distances

(The left figure is the object when the Start offset and End Offset are 0,

and the right figure is the object when the Start offset and End Offset are both

0.5.)

Average distribute line: The solution the starting and ending hatch line are non-average
distributes question when the object is hatched. After select this item, the software automatic
adjust the hatch line space in the user setting hatch line space foundation, will let the hatch line
average distribute.

Linereduction: The hatch line both sides reduction. (Figure 3-10)

NumLoops: The times of Ring-like hatch before the aclinicing hatch (Figure 3-11).

Figure 3-10 Linereduction

( The left figure is the object when the Linereduction is 0,the middle figure is the object

when the Linereduction is 0.5, and the right figure is the object when the Linereduction is -0.5)
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Auto rotate hatch: Refers to after every marking, the hatch line will fill the revolving angle
which we setted automatically to marking again. For example, angle is 0, auto rotate angle is 30,
the first mark angle is 0, the second is 30, the third is 60, and so on.

Undo Hatch: delet hatching
Hatch one by one: choose multi object and hatch together, after hatch, still independent

object.

3.6 To Curve

“To Curve” turns the current selected vector graphics object into curve object

3.7 To Dashed

‘To Dashed’ turns the current selected vector graphics object into dashed object, as fig 3-12

Fig 3-12 turn vector graphics into dashed object
Use could set the length of the line and the distance between two lines

Figure 3-11 NumLoops

( The left figure is the object when the NumLoops is 0,and the right figure is the object when the NumLoops is 2)
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3.8 Offset

Offset dist: the distance between the old curve and original object
After user set the offset distance, click on the right side of the object, object will move right, click
left side of the object, object will move left side.

3.9 UnGroup Text

Make the text into group according to each character, then object name of the group is the
name of the character.

Chapter 4 Draw Menu

“Draw Menu” consists of various common items for drawing, for instant, Dot, Line, Curve,
Polygon, etc. Draw Menu has a Toolbar correspondingly, and all the operations can be achieved
by pressing the icon on the Toolbar. For example, as Figure 4-1 shows, when you have selected
the drawing command or the icon in Toolbar, the Present Command Toolbar on the top of the main
window will be changed to show some options of the current command.

Figure 4-1 Draw Menu
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4.1 Point (D)

To draw a dot in the working space is one of the easiest drawing operations. When selected,
the mouse pointer will be changed into a cross feature, and users just press the left button of the
mouse in an appropriate place, a dot can be drawn. Also users can draw more dots by pressing the
left button, when it is finished, user can press the right button of the mouse to end the drawing
command, and then the last dot drawn is displayed as selected object.

Under dot drawing mode, the Present Command Toolbar will be displayed as:

used to draw a dot

If users press button , a set of dots with equal distance will be placed along a curve. Click

this button, the tool bar becomes:

Point num: the amount of dots settled on the curve
Point dist: the distance between the two bordered dots
Start Offset: the distance between the first dot and the beginning of the curve

Note: if it can’t carry all the points, system will put remaining points from the start of the curve
till finish all the points use set in ‘Point num

’use can set point distance as user need, system will calculate point num as the point

distance.

4.2 Curve

To draw a curve, users can select command “Curve” in the Draw Menu or click the

icon . (Figure 4-2)
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When command “Curve” selected, users can draw free curves by pressing the left button of
the mouse and drag it.

When command “Curve” selected, users can move the mouse to the nodes on the middle of
the curve and press the left button of the mouse to delete the current node.

When “Curve” commands selected, user can move the mouse to the node on the beginning of
the curve and press the left button of the mouse to close the current curve automatically.

When command “Curve” selected, users can move the mouse to the node on the end of the
curve and press the left button of the mouse to change the node of the current object into “sharp”.

When command “Curve” selected, users can move the mouse to the points which are not
nodes and press the left button of the mouse to add a node to the current position of the curve.

4.3 Rectangle

To draw a rectangle, users can select command “Rectangle” in Draw Menu or click the

icon .

Under the command “Rectangle”, users can press the left button of the mouse and drag it to
draw a rectangle.

Figure 4-2 Draw a Curve
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Under the command “Rectangle”, users can draw a square
by pressing the left button of the mouse and drawing it when
press “Ctrl” key synchronously.

After drawing and selecting, the Properties Toolbar will
display a feature like Figure 4-3 shows.

Arc radius: This refers to the smooth degree of the
rectangle’s four corners, and when the degrees are 100%, then
the rectangle changes into a circle.

All corner Round: When selected, users can change the
angles of the four corners at the same time just by changing one
of them.

NOTE: After changing the parameters in the Properties
Toolbar each time, we must click “Apply” button to update
the object with new parameters.

4.4 Circle

To draw a circle, users can select command “Circle” in the Draw Menu or click the

icon .

Under the command “Circle”, users can press the left button and drag it to draw a circle.
After drawing and selecting, the Properties Toolbar will display a feature like Figure 4-4

shows.

Diameter: the diameter of the circle
Starting Angle: the angle between the starting

point and the centre of a circle

: This figure refers to the drawing

direction of the circle is clockwise.

: This figure refers to the drawing
direction of the circle is anticlockwise.

4.5 Ellipse

To draw an ellipse, users can select command “Ellipse” in Draw Menu or click the icon.

Figure 4-3 Rectangle Properties

Figure 4-4 Circle Properties
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Under the command “Ellipse”, users can press the left button of the mouse and drag it to
draw an ellipse.

Under the command “Ellipse”, users can draw a circle by pressing the left button of the
mouse and drawing it when press “Ctrl” key synchronously.

After drawing and selecting, the Properties Toolbar will
display a feature like Figure 4-5 shows.

Start Angle: the angle between the starting point and the
centre of an ellipse

End Angle: the angle between the ending point and the centre
of an ellipse

: This figure refers to the drawing direction of the

ellipse is clockwise.

: This figure refers to the drawing direction of the
ellipse is anticlockwise.

4.6 Polygon

To draw a polygon, users can select command “Polygon” in Draw Menu or click icon .
Under the command “Polygon”, users can press the left

button of the mouse and drag it to draw a polygon.
After drawing and selecting, the Properties Toolbar will

display a feature like Figure 4-6 shows.

Edge Num: This item indicates the number of the
polygon’s borders, and that is at least three. Normally the
border number is less than ten, and with borders more than ten
the polygon will look like a circle.

: When selected, the current polygon to be drawn will
be a convex polygon.

: When selected, the current polygon to be drawn will
be a star.

4.7 Text

Figure 4-5 Ellipse Properties

Figure 4-6 Polygon Properties
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Typing text directly in the work space is supported in EzCad2, and many types of fonts are
supported. To type text, users can select command “Text” in the

Draw Menu or click icon.

Under the command “Text”, users can set up a starting point
at any position wanted in the work space to type characters by left
click mouse.

4.7.1 Character Properties

When selected, the Properties Toolbar will display a feature
like Figure 4-7 shows. Users may change the characters by typing
in the text box.

EzCad2 supports five types of text. (Figure 4-8)
When users select a type, a font list under that type will

appear to show all the available fonts. Figure 4-9 is the list of
TrueType.

Figure 4-10 is the list of Barcode Type.
Height: the average height of characters

: Figure 4-11 shows the dialog box after clicking

this icon.

: When selected, the current text aligns left.

: When selected, the current text aligns

center.

: When selected, the current text aligns

right.
Bold: When selected, the current text become
bold.
Italic: When selected, the current text become
italic.
Enable the same width character: make the
width of all characters the same
CharWidth: the average width of characters
Char Angle: the degrees the characters incline
Char space: the distance between characters
Lines space: the distance between rows
Empty char width: the width of empty char

4-7 Character Properties

Figure 4-8 Types of Text

Figure 4-9 TrueTpye List
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4.7.2 Curve text function
EzCad2 support curve text function, if the user draw text near enough from the curve, the text will

arrange along the curve. When current text is curve text, click , fig 4-12 will pop-up:

Figure 4-10 List of Barcode Type

Figure 4-11 Character Options
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mean text will be parallel with

the curve, as fig 4-13.

Fig 4-13 normal arrange

means text will be vertical with

the curve, as fig 4-14.

Fig 4-14 vertical arrange

means the base line of the text is superposition with the curve, as

fig 4-13.

means the top of the text is superposition with the curve, as

fig4-15.

Fig 4-15 top arrange

means bottom of the text is superposition with curve, as fig 4-16.

Fig 4-12 curve text
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Fig 4-16 bottom arrange

means middle of the text is superposition with curve, as fig 4-17.

Fig 4-17 middle arrange

means text stay on the curve freely along with the curve, the

position of the text is up to as fig 4-18.

Fig 4-18 freely arrange

put text on the other side of the curve, after this function, fig 4-13 will like fig 4-19.
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Fig 4-19 put text on the other side of the curve

when put text on circle, we use this function.
Base angle: means the angle of the base line of the text.
Angle range limit: when we click it, no matter how many characters we input, system will

compress all the characters in the limit angle, as fig 4-20.

Fig 4-20 limit the angle as 45
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4.7.3 Circle Text

EzCad2 supports circular text, after select in the figure 4-11, the text will align

according to the user definition circle diameter.
The demonstration graph in Figure 4-12 is according to
Figure 4-11 parameter making.
Base angle: The benchmark of the text aligning the circle.
Angle range limit: When checked, no matter how much
chars that users type in, the text will be limited in the angle
range. (Figure 4-13)

Figure 4-13 Comparison of Two Texts (Limiting Angle is 45 degrees.)

4.7.4 Barcode Text

When users click the icon , a dialog box will be displayed as Figure 4-14 shows.

Figure 4-12 Circle Text
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Figure 4-14 Barcode Text

1. Sketch Map
The sketch map is that the current barcode will look like.

2. Barcode Information
The barcode explanation shows some information about the current barcode’s format,
and if users are not very clear with the format, it is recommended to read the tip first to
get to know what types of characters is valid.

3. Text
This item refers to the text to be made into barcode. And if the characters users types in

the Text space is valid, there will be a cross selected in which shows the
current characters are valid for being made into a barcode.

4. Show Text
Whether to show a corresponding text under the barcode (Figure 4-15)
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Figure 4-15 Show Text

Hatch：The text is hatched as the setting of hatch in the show text if the hatch is selected;
otherwise the hatching is the same as barcode.
Font: The font of the current characters to be displayed
Width: the width of the characters
Height: the height of the characters
Text Offset X: When selected and set up, the text displayed under the barcode will be
moved towards either the positive or the negative directions of X axis.
Text Offset Y: When selected and set up, the text displayed under the barcode will be
moved towards either the positive or the negative directions of Y axis.
Text Space: the space between characters

5. Quiet:
Refer to the size of the barcode’s blank area, when let the barcode “Reverse” valid.

 One-Dimensional Barcode
This kind of barcode consists of bar and space one by one. The barcode information is
carried by different width and position of the bars and space, and the information
volume they carry is decided by the width and the precision. Wider the barcode is, more
the bars and the space included, and more information carried. This kind of barcode
technology can store information towards only Unidirection through permutation and
combination of the bars and the space, and so it is called one-dimensional barcode.
Figure 4-16 shows a feature of parameter setting when a one-dimensional barcode is
chosen.
CheckNum: This refers to whether the current barcode needs verify code. Users can
freely choose which barcode they would like to add verify code on, and users have the
decision whether to use the verify code or not.
Reverse: This refers to whether to reverse the parts which should be marked into the
unexpected parts of an object. This function is used in some materials which appear
light color after the marking.
Bar Height: the height of the barcode
Narrowest Width: This refers to the width of unit bar. Commonly a one-dimensional
barcode consists of bars with four types of width and space with four types of width, 1
\ 2 \ 3 \ 4. The narrowest bar’s width indicates the width is 1 unit.



EzCad2UNI User’s Manual

38 All rights reserved

 

Interchar space 

Figure 4-16 One-Dimensional Barcode Parameter

Setting
Figure 4-17 Characters’ Distance

Interchar space: It is prescribed that some barcodes have distance between characters. (e.g.
Code 39) This parameter is used to set this like Figure 4-17 shows.
Use Inter Hatch Line: If the facula diameter of laser bean is big, there will be a half facula
over boundaries after common hatch, then the code gun can not distinguish because actual
marking width is bigger than design width. So we specially design this hatch. The hatch line
is bow line and don’t have contour.
Laser Bean Diameter: The size of laser facula.
Hatch Line Distance: The space between two hatch lines
Scale:

Bar: setting the width of one bar.
Space: setting the width of the space,

Quiet:
Refer to the size of the barcode’s blank area, when let the barcode “Reverse” valid. The
actual size of the blank area is the multiple of the unit bar.

 Two-Dimensional Barcode

1. PDF417 Barcode

Figure 4-18 PDF417 Barcode Figure 4-19 Compress PDF417 Barcode
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PDF is the abbreviation of the Portable Data File. Figure 4-18 is the demonstration of
PDF417 Barcode and Figure 4-19 of the Compress PDF417 Barcode. Figure 4-20 is the
parameter setting of the PDF417 Barcode.

Bar Height: the height of the barcode
NarrowWidth: This refers to the width of the unit bar.
Level: the Error-Checking Level of PDF417 barcode, from 0 to 8
Lines and Columns: the lines and Columns of PDF417 barcode

Figure 4-18 shows a feature of a barcode with the row’s number is four and the column’s is four.

Figure 4-20 PDF417 parameter

2. Data Matrix Barcode:
Data Matrix is a kind of two-dimensional barcode based on Matrix, and currently there are

two types: Ecc000-140 and Ecc200. EzCad2 supports Ecc200 at present.
Figure 4-21 shows the parameter setting of Data Matrix Barcode.

Figure 4-21 Data Matrix Barcode Parameter Setting Figure 4-22 Data

Matrix Barcode

Size

Figure 4-23 Data Matrix

Barcode Width

Data Matrix has various fixed size, and users can choose what they want. If the smallest
size is chosen, the system will automatically select the smallest frame to fit the all text users have
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typed.
NarrowWidth: the width of the unit bar (Figure 4-23)

3. QRCODE Barcode:
QRCODE Barcode is two dimensional (2D) code format. The character set includes all

ASCII values. There are no size restrictions.
The figure 4-24 ，4-25， 4-26 are the parameter of QRCODE Barcode.

Figure 4-24 QRCODE Barcode Figure 4-25 QRCODE Barcode text setting

Figure 4-26 QRCODE Barcode Parameter Setting

4. MicroQRCODE
Simply of QR code

5. CHINESE-SENSIBLE CODE
Chinese 2D barcode, include all the ASCII and chinese words

6. USER DEFINE Code:
USER DEFINE Code is user can define code format by self. Figure 4-27 and figure 4-28 are

the demonstration of user defines code.
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Figure 4-27 USER DEFINE Code Parameter Setting

Figure 4-28 USER DEFINE Code

4.7.4 Variable Text

The function of variable text is available after is selected.

Variable Text is a disciplinary and dynamic text which can be customized during the operation.
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Figure 4-29 Variable text attributes

The adjacent character distance in current text character arrangement situation

What the adjacent character spacing's computation refers to is left side the

character right boundary to the right side character left boundary distance, see the figure 4-30:

Figure 4-30 Calculate spacing according to character boundary

What the adjacent character spacing's computation refers to is left side the

character center to the right side character center distance, see the figure 4-31:
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Figure 4-31 Calculate spacing according to character center

is the special array uses in the variable text array, when uses this array the time text

to change automatically, but 2.11 object property said the array will not change the text object, this
is the difference about these two array.

Inside the EZCAD2 international edition the variable text is a character string according to
successively the order by each kind of different real-time change text element. The user may
according to need to increase each kind of variable text element, may carry on the order of rank to
the text element.

After the user click “increases”, the system will display a dialog box as Figure 4-32 shows.

Figure 4-32 Text element dialog box
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Currently EzCad2 supports 9 types of variable text:
Fixed text: refers to the fixed invariable element in the operating process.
Serial number: The system will change the text according to the fixed increment when in

the operating process.
Date Code: When the operation is taking place, the system will automatically pick up the

date information from the computer as a new formed text.
Time: When the operation is taking place, the system will automatically pick up the time

information from the computer as a new formed text.
TCP/IP communication: When the operation is taking place, the system will pick up the text

from the network
Serial communication: When the operation is taking place, the system will pick up the text

from the serial port
File: The system will seriatim read what to be marked in the customized text file line by line.
Keyboard: Users can type text to be marked through keyboard when the marking is in

process.
SQL database: The system will seriatim read what to be marked in the database line by line.

Fixed text

The fixed text is refers to the fixed invariable element in the operation process.

Figure 4-33 Fixed text

Change Line character: uses in variable text, can resolve the question about multi-text must
branch marking. When application, increases one change line character between two variable texts,
the software according to the change line character position automatic text branch. If many texts
need to divide into the multi-lines, only need in the behind where want to branch's text to increase
one change line character.
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The fixed text has a special option is , when chooses this item, the system uses

the current user name to replace the fixed text automatically.
Below explains with examples the situation needs to use in the fixed text the user name

function.
If the present must process one batch of work piece as shown in Figure 4-34, because the

worker is every day three number of runs in turn, in order to control the quality to need each
operator marks his own name, does not process the part in the work piece. Because only the
designer and the administrator have the jurisdiction of change processing document, the operator
is unable to change the processing document to increase own name, this time needs to use in the
fixed text the user name function.

The administrator must enable “You must enter and password before using” (see Chapter
2.6.7), then sets a user name and the password for each operator. The designer completes the
processing document which as shown in Figure 4-34, the last text sets the user name in the object
list. After like this each operator goes to work, after opening EZCAD2, must input own user name
and the password, in processes this document time, the system alters to automatically the last text
operator's name.

Figure 4-34 the processing example has the user name in the fixed text

Serial number

Serial number text is a text which is changed according to the fixed increment when in the
operating process.
When selected, a serial number parameter setting will automatically appear in the variable text
dialog box. (Figure 4-35)
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Figure 4-35 Serial number parameter definition

Mode: The mode current series number used, see the figure 4-36.

Figure 4-36 Serial number mode

Dec: Series number carry according to decimal system, the effective character is from zero to
nine.

HEX: Series number carry according to capital letter hexadecimal system, the effective
character is from A to F

hex: Series number carry according to small letter hexadecimal system, the effective
character is from a to f

User define: The series number carry defines according to user define system, after selecting,
the system will display a dialog box like Figure 4-37 shows.
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Figure 4-37 User define other number system dialog box

The user can define carry ways discretionary between 2 to 64, only needs to define the max
number, and then revises each serial number correspondence the text
Start SN: This item indicates the first serial number to be marked at the present
Current SN: the serial number to be marked at the present
Limit: when mark the limit serial number, it will back to start serial number automatically
Increment: the increment of the current serial number. The value may be plus or minus
When the increment is “1”, and if the starting serial number is 0000, there will be an increment
“1” added on the previous serial number. For example, 0000, 0001, 0002, 0003 … 9997, 9998,
9999, and when it comes to 9999, the system will be back to 0000 automatically.
When the increment is “5”, and if the starting serial number is 0000, the serial number is: 0000,
0005, 0010, 0015, 0020, 0025 …
Others can be analogized by this.
Marks per: the marked number. This item indicates how many times every serial number is
marked before changing.
Current num: the marking time of current serial number, when marking number equals to marks
per, it will turn to 0 automatically

if click it, software won’t mark special number in special digit.

won’t mark numbers end with 4, * means any digit.

Reset: The number will become the start SN in the set time.
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Date Code

When the operation is taking place, the system will automatically pick up the date
information from the computer as a new formed text.

When selected, a date parameter definition will be shown in the dialog box automatically. As
Figure 4-38 shows, users can directly choose the type they prefer.

Figure 4-38 Data parameter definition

Year－ 2008: Use computer clock's current year for corresponding text, the form is four
characters.

Year－ 08: Use computer clock's current year for corresponding text, the form is two
characters: latter two digits are effective of the year.

Month－ 07: Use computer clock's current month for corresponding text, the form is two
characters.

Day－04: Use current computer clock's each month's date for corresponding text, the form is
two characters.

Day－ 186: The use current computer clock this day takes the corresponding text from
January 1 number of days, the form is three charactes. (What 001 represent is on January 1 , what
002 represent is on January 2, what 003 represent is on January 3, ex analogia)

Day of week－5: Use current computer clock's week date for corresponding text, the form is
one character

Week of year－27: The use current computer clock this day is this year's several week for
the text which corresponds, the form is two characters (from January 1 to January 7 is 01, from
January 8 to January 14 is 002, ex analogia)

Date: When system read computer clock's date, needs to add on the the displacement date is
the finally date, this function mainly uses in the work piece processing having the production date
and guaranteeing nature date professions and so on food.

User-defined month character: When selected the month as the corresponding text, the
Figure 4-39 will be shown. Users can define the month character, changes to other characters that
no longer uses the digit which the software defaulted, only needs double-clicks the selected month,
input the month other characters, finally the month which shown on the software workspace is
with the input character.
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Figure 4-39 User-defined month character

click it, follow dialog will show, user could define year as user need

Time

When the operation is taking place, the system will automatically pick up the time
information from the computer as a new formed text.

When selected, a time parameter definition will be shown in the dialog box automatically. As
Figure 4-40 shows, users can directly choose the type they prefer.

Figure 4-40 Time section

Hour－24: Use current computer clock's hour for the corresponding text, the time format is
24-hour-setting

Hour－12: Use current computer clock's hour for the corresponding text, the time format is
12-hour-setting
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Minute: Use current computer clock's minute for the corresponding text.
Second: Use current computer clock's second for the corresponding text.
Time Section: Divides into 24 time sections one day of 24 hour, the user may define each

time section is a text. This function mainly uses in the work piece the processing needing to have
the number of runs information.

TCP/IP communication

When the operation is taking place, the system will pick up the text from the network.
Notice: The network interface in here is the network interface uses in TCP/IP agreement.
When the user selected the “TCP/IP communication”, the parameter defines will display

automatically in the dialog box, see the figure 4-41:

Figure 4-41 TCP/IP communication parameter definition

IPAddress: select the IP address which from reads the data
Port: select the port the TCP/IP communication used
Command: When the system processes to this text object, the system through the

network interface to transmit this order character string to a computer assigned the IP address,
request the computer sends the character string needs to process at present, the system will not
return until the computer replied, after the response of the computer, the system will process the
returns text automatically.

Unicode: After choosing this option, the system to the computer transmission which and
the read character is the Unicode form, otherwise is the ASCII form.

The following example showed how to use this function:
Now has a customer to process 10000 work pieces, on the work piece the marking content is

a text, but each work piece must process the text content is dissimilar, therefore, before each work
piece processing, must real-time read the processing content through the network from the local
area network a computer server (IP: 192.168.0.1 port is 1000) on.

1． Open ezcad2 to establish a text object, adjust the text size, the position and the
processing parameter.

2． Choice the text object, select the “enables variable text”, click the “increase” button, the
system will spring a Figure dialog box as 4-32, select TCP/IP communication, set the
network interface parameter, the IP address parameter fills in server computer's IP, here
is 192.168.0.1; the port parameter sets to use in the communication the port number, here
is 1000, the network interface parameter must identically with the server computer on ,
otherwise it will cause to be unable communication.

3． Set the command is TCP: Give me string.(This command may for the random server
definition command)
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4． After closing the dialog box, click the application button.
5． Click F2 to start to process, the computer will send the command “TCP: Give me string”

to the server immediately through the net mouth, and waited for that the server will
return.

6． After the server discovered the network interface receives the command is “TCP: Give
me string”, reads the database immediately to obtain the text which the current must
process, then gives the local computer through the network interface reply.

7． After the local computer obtains the text which must process, changes the processing
data to transmit immediately to the marking board.

8． After the marking board receives the processing data, control the machining to mark the
work piece immediately.

Flow chart as shown in Figure 4-42:

Figure 4-42: TCP/IP communication flow chart

Serial communication

When the operation is taking place, the system will pick up the text from the serial port.
When the user selected the “Serial communication”, the parameter defines will display

automatically in the dialog box, see the figure 4-43
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Figure 4-43 Serial communication parameters

Port: the port which computer and peripheral equipment connection used
BaudRate: the BaudRate which the serial communication used
DataBits: the DataBits which the serial communication used
StopBits: the digits of StopBits of which the serial communication used
Parity: select the digits of Parity which the serial communication used
Command: When the system processes to this text object, the system through the serial port

to transmit this order character string to a peripheral equipment, request the peripheral equipment
sends the character string needs to process at present, the system will not return until the
peripheral equipment replied, after the response of the peripheral equipment, the system will
process the returns text automatically.

Unicode: after choosing this option, the system to the computer transmission which and the
read character assigns is the Unicode form, otherwise is the ASCII form.

The following example showed how to use this function：
Now has a customer to process 10000 work pieces, on the work piece the mark content is a

text, but each work piece must process the text content is dissimilar, therefore, before each work
piece processing, must real-time through the serial port (On serial port parameter establishment
server: the BaudRate is 15200, the DataBits is 8, the StopBits is 1, the Parity is NO)the content
which the read must process to other server on.

1. Open ezcad2 to establish a text object, adjust text size, the position and the processing
parameter.

2. Choice the text object, select the “enables the variable text”, click the “increase” button,
the system will spring a Figure dialog box as 4-32, select Serial communication, the
setting of serial port parameter must with server's serial port parameter correspondence
(the BaudRate is 15200, the DataBits is 8, the StopBits is 1, the Parity is NO), the port
for current the port number which uses with it connected server, the serial port parameter
must establish identically with the server computer on

3. Set the command is COM: Give me string. (This command may for the random server
definition command).

4. After closing the dialog box, click the application button.
5. Click F2 to start to process, the computer will send the command “COM: Give me

string” to the server immediately through serial port and wait for that the server will
return.

6. After the server discovered the serial port receives the command is “COM: Give me
string”, reads the database immediately to obtain the text which the current must process,
then gives the local computer through the serial port reply.

7. After the local computer obtains the text which must process, changes the processing
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data to transmit immediately to the marking board.
8. After the marking board receives the processing data, control the machine to mark the

work piece immediately.
Flow chart as shown in Figure 4-44:

Figure 4-44 Serial communication flow chart

File

Txt files and Excel files are supported now.
1．Txt files

When select TXT file, a dialog box as
Figure 4-45 shows will be displayed
to ask for the file’s name and the
current text’s line number.

Auto reset: If checked, the line
number will change to 0 automatically
when reach the last line. The next
mark will start from the first line
again.

Read all lines: When processes to the text document direct read entire document.
2．Excel files

Figure 4-45 TxT document parameter definition
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Figure 4-46 Excel document parameter definition

We have to appoint the file name, Field name, Line number to tell the software which cell in
the excel table will be mark.

File name: The text string of the first row in the datasheet1. This parameter indicates which
column will be marked.

Keyboard

The keyboard element is the text which must process from the keyboard entry by the user,
when select the keyboard element, a dialog box as Figure 4-47-a shows will be displayed to ask
for the user set the keyboard element parameter.

Fixed char count: user must
input string with digit equals to this
count

Prompt: In the processing, the
system will spring the input dialog
box which ask for the user input the
processing text when meets the
keyboard variable text, like the figure 4-47-b shows, this time the user direct by-hand input the
text.

Set Pen Param: When selected, we can get power, speed, frequency from the keyboard entry,
only through setting pen*.power, pen*.speed or pen*.freq. The “*” is number of pen.

The keyboard element function uses frequently in this kind of situation when the processing
needs the real-time input to the processing content. If the customer present need processes one
batch of work pieces, on each work piece is printed with a bar code, when processing needs the
user with the bar code scanning gun real-time scans the work piece to read the content on the bar
code, then with laser to mark to the work piece assigns in the position, at this time can use the
keyboard element function. At the processing time system springs like the figure 4-47-b shows the
dialog box, the operator with the bar code scanning gun scanning bar code work piece on, the bar
code scanning gun inputs the read content to the dialog box inside and closes it automatically, then
the system will start to process the content read a moment ago automatically .

Figure 4-47-a Keyboard element parameter
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Figure 4--47-b Keyboard input text dialog box

Advance

Click “Advance” then the dialog box will be displayed shown as Figure 4-48
Enable fixed width: no matter

how long is the text, the length will be
limited in this range.

Mark Self: In certain situations,
the user need division the input
keyboard text then places them the
different position to mark,
simultaneously also needs to mark this
keyboard text, application this
function can achieve this requirements
After set the parameters of the
division character, select “Mark Self”,
when the marking, marks the division
character besides, will also mark all
keyboard text in the corresponding
position which input a moment ago.

At present, the Advance function has split character string function. The following processing
example will explain it.

For example: In Beijing Olympic Games ticket prints on the bar code has the sports field
entrance number as well as the seat number information, but the human is unable to distinguish
the bar code directly, must use the laser to mark this information to the ticket assigns in the
position. At this time we may use the split character string function, through the bar code scanning
gun read the series number, then split the series number automatically, and processes to assigns the
position. As shown in Figure 4-49 the Olympic Games ticket sketch map, the bar code following
serial number is the bar code content, the serial number altogether has 7 characters, first 3
character expression entrance number, latter 4 character expression seat number, what bar code
scanning gun read-out is the entire character string, EZCAD2 must split the reads series number
according to the request and puts to assigns the position automatically.

Figure 4—48 Advance function dialog box
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Figure 4—49 Olympic Games ticket sketch map

1．First establishes a keyboard variable text:
establish text—→enable variable text—→add—→keyboard, such as the figure 4-50-a:

Figure 4-50-a Keyboard

2. Input prompting message, click “OK”, then we can obtain the figure 4-50-b.
3. Select “Advance” then the dialog

box will be displayed shown as Figure
4-48.

4. Selects “enable split string to
change other text entity” to revise has
assigned the name text object, click
“Add” then the dialog box will be
displayed shown as Figure 4-50-c.

Index of the first character in
string: In the TEXT1 text the first
character is the several characters in
the keyboard variable text character
string.

Figure 4-50-b Keyboard text parameter
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The number of characters to extract from string: extract how many characters in the
keyboard variable text's character string.

The name of text entity which you want to change: The fixed text name the split read's
character is at.

Add Char Mode: click it then add the split characters behind of the text

Figure 4-50-c Add split character string parameter

Here increases two conditions, one is revises TEXT1 the object, starts from the 1st character
to take 3 characters, other one is revises TEXT2 the object, starts from the 4th character to take 4
characters. At last the result like the figure 4-50-d shows the dialog box.

5. Set two text objects and
change its name TEXT1,
TEXT2. Here should pay
attention to the keyboard
variable text must arrange
before two fixed texts in the
object list, the TEXT1 object
places the position which the
entrance number must
process, the TEXT2 object
places the position which the
seat number must process,
then set the processing
parameter.

6. Click “Mark” then the dialog
box will be displayed shown as Figure 4-50-e, the user use bar code scanning gun
scanning the ticket's bar code, the system will put the series number division to inside
TEXT1 and TEXT2 and process automatically.

Figure 4-50-d The result add split character string
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Figure 4-50-e Keyboard input prompt dialog box

4.8 Bitmap

To add a photo, users may select command “Bitmap” in the Draw Menu or click icon in

the Toolbar

Figure 4-51 Add a photo

Then the system will pop a dialog box as Figure 4-51 shows to open a graphic file.

The current supported graphic file formats are: Bmp；Jpeg, Jpg；Gif；Tga；Png；Tiff, Tif；
Show Preview: When users select a graphic file, there will be a preview displayed in the

dialog box.
Put to center: put the photo’s center in the origin

When finishing adding a photo, a “Bitmap” parameter setting will appear in the Property
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Toolbar as Figure 4-52 shows.

Dynamic file: whether to reread files when in process.
Fixed DPI: When selected, the system will fasten the

unfixed DPI of dynamic photo. The higher the DPI’s level is,
the closer the dots gather; and the photo’s precision is better,
then the marking time is longer.

DPI: dot per inch; 1 inch is about 25.4 millimeters
Fixed Size X: When checked, the width of the dynamic

photo will be preserved in an appointed size, and if unchecked,
the photo’s width will be the original size of the photo.

Fixed Size Y: When checked, the height of the dynamic
photo will be preserved in an appointed size, and if unchecked,
the photo’s height will be the original size of the photo.

Fixed position: the benchmark the dynamic photo based
on while in size changing

Image Manipulation:
Invert: run negative effect on photos (Figure 4-53)

Figure 4-53 Invert Effect (Left is original.)

Gray: change color photos into grey of level 256 (Figure 4-54)

Figure 4-52 Bitmap Parameter
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Figure 4-54 Color and Grey (Left is original.)

Dither: This effect is similar with the function “Grey Adjust” in Adobe PhotoShop. It uses
color black and white to simulate grey image, so as to achieve a grey effect with dots arranged in
different densities, as Figure 4-55 shows. (The white bar in the photo was caused by display,
which will not be marked.)

Figure 4-55 Dither

Click the “Expand” button to run the “Bitmap” dialog box. (Figure 4-56)
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Figure 4-56 Bitmap Dialog Box

Lighten: adjust the current image's brightness and contrast values.
Scan Mode:
Bidirectional Scan: the scan mode is bidirectional when in marking process (Figure 4-57)

Figure 4-57 Left is unilateral scan; right is bidirectional.

Mark Mode:
Drill mode: whether the laser is kept on or restricted in appointed time for each dot’s marking

when in process
Adjust Power: whether the laser’s power is adjusted according to each dot’s grey level when

in process
Expand Parameter: Figure 4-58
Y Scan: The scan will run along Y axis line by line.
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Scan line Increment: This item indicates whether to scan line by line or skip some
lines. This function may quicken the marking speed when in low precision marking requirement.
Disable Mark Low Gray Point: This item indicates that every point is marked or only marking
bigger gray points. This function may quicken the marking speed when in low precision marking
requirement.
Line feed malposition: The point isn’t aligned between two adjacent rows, but the point is aligned
with the position which is the middle of two points in the previous line, to avoid the trace of
marking.
Gray-Power figure: For improving marking results, can modify some of the gray scale
corresponds to the power
Optimize Mode: calculate the marking speed according to the DPI and frequency to optimize
marking speed and result
BiDir Offset: improve the edge not alignment marking problem
ACC.Distance:this parameter is used for remove the offset of BiDir scan model

Figure 4-58 Scan Parameter
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4.9 Vector File

To input a vector file, users can select command “Vector File” in Draw Menu or click

icon .

Figure 4-59 Input a Vector File

There will be a dialog box pop up to ask for the vector file to be inputted.

The current supported vector file formats are: PLT；DXF；AI；DST; SVG; NC;BOT
NOTE: If the vector files includes color information (when draw it by image software

like CorelDraw, AutoCAD, Photoshop and so on), Ezcad can distinguish the color
automatically. Then user can pick the object according to the color or pen (see Chapter 4.12)
and set marking parameters (see Chapter 10.1 “color”, “pen”)



EzCad2UNI User’s Manual

64 All rights reserved

When users have opened a vector file, a vector file
parameter setting as Figure 4-60 shows will appear.

4.10 Time-lapser

To input the Time-lapser, users can select command

“Time-lapser” in Draw Menu or click icon .
When selected, there will be a property setting of the

time-lapser displayed in the Property Toolbar as Figure
4-61 shows.

Waiting time: The marking will pause until the
specific time has passed.

4.11 Input Port

To check the Input signal, users can select command “Input Port” in the Draw Menu or click

icon .

When selected, there will be an input port property
setting appearing in the Property Toolbar as Figure 4-62
shows.

I/O Control Condition: The software will pause
until the input signal is the same as the I/O control
condition.

Message: If checked, the software will pop up a
message box to info the user. The message text can be
custom defined.

4.12 Output Port

To output signal, users can select command “Output Port” in the Draw Menu or click the

icon .

When checked, there will be an output port property setting appearing in the Property Toolbar
as Figure 4-63 shows.

Figure 4-60 Vector File Parameter Setting

Figure 4-61 Waiting Time

Figure 4-62 Input Parameter
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: This icon indicates that the system will export a

high-level voltage (TTL compatible) when the operation is
taking place at the current output port.

: This icon indicates that the system will export a

low-level voltage (TTL compatible) when the operation is taking
place at the current output port.

: This icon indicates that the system will export a

fixed-level.

: This icon indicates that the system will export a pulse.

4.13 Select

Icon on the top of the Draw Toolbar is used to select object. The pressed-down state
of this icon indicates that the current command is “select”. Now, you can use mouse to click object
in the workspace to select it. EzCad2 software has “auto-snap” function. When you move the
mouse in the workspace and approach to a curve, the mouse pointer will automatically be changed

into , and now you can press the left button of the mouse to select the object.

Figure 4-64 Select Toolbar

You can also select an object by moving the mouse while pressing the left button of the
mouse, and there will be a dashed frame appearing in the area as the mouse move. This selection
method is called “Frame Select”. If the moving direction of the mouse is from left to right, then
only the objects completely involved in the dashed frame will be selected; and if the moving
direction of the mouse is from right to left, then all the objects touched by the dashed frame will
be selected.

Figure 4-63 Output Parameter
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Figure 4-65 Lock an Object

When command “Select” is chosen, a Select Toolbar will appear, and you can achieve some
specific operations. (Figure 4-64)

: This icon indicates to select all the objects in the current workspace.

: Invert Selection

: This icon indicates to delete the current object selected.

: This icon indicates that the current object is locked. Users can not take any operation

on the locked object, and there will be some lock-like icons appearing around the object.(Figure
4-65)

: unlock the object locked

: This icon indicates to unlock all the objects locked.

As Figure 4-65 shows, the Bezier Curve is locked and the circle is not, and now you cannot
take any operation on the curve object, such as editing, modifying, moving, zooming, etc.

: Put object selected on the origin

: This icon indicates to use different pen to select objects. When clicked, a dialog box as
Figure 4-66 shows will appear.
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Figure 4-66 Select object by Pen

4.14 Node Editing

All the objects drawn in EzCad2 are vector graphs. Users can modify an object’s shape by
editing the nodes.

To edit nodes, you may press icon in the Draw Toolbar. When clicking an object in the

work space, there will be a node appearing around the object. Nodes are denoted as hollow
squares, and the bigger one is the starting point of the curve. When selected, a Node Editing
Toolbar will appear as Figure 4-67 shows.

(a)

(b)
Figure 4-67 Node Editing

(a) Nodes (b) Node Editing Toolbar
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 : This icon is used to add a node. When click any point on the curve where has no node,

there will be a black solid circle appearing, and now users may add a node by click this icon.

 : This icon is used to delete a node. When clicking any node on the curve, the node will
be blacked, and here users may click this icon to delete it.

 : This icon is used to combine two nodes. If two nodes are close enough, users may
“frame select” the two nodes and click this icon to combine them into one node.

 : This icon is used to separate a node. When users click a node on the curve, the node
will be blacked, and then we may click this icon to separate this node into two separated
nodes.

 : This icon is used to turn curves into lines. Users may click any position between two

neighbored nodes and select the command “Line” to make the curve (line/arc/curve) between
the two nodes into a line.

 : This icon is used to turn curves into arcs. Users may click any position between two
neighbored nodes and select the command “Arc” to make the curve (line/arc/curve) between
the two nodes into an arc.

 : This icon is used to turn curves into curves. Users may click any position between two

neighbored nodes and select command “Curve” to make the curve (line/arc/curve) between
the two nodes into a curve.

 : This icon is used to sharp a node. When selected, a sharp will take the place of the

node, and the curve is sharp.

 : This icon is used to smooth a node. When selected, the node will be changed into a

smooth curve.

 : This icon is used to symmetrize a curve. If you click a node and select command

“Symmetrize”, the curves on both sides of the node will be symmetrized.

 : This icon is used to change the directions of a curve, by exchanging the starting and

ending points.

 : This icon is used to close a curve.

 : This icon is used to align objects. When users “frame select” more than two nodes and

click this icon, a dialog box of Aligning Nodes will appears, and you can choose the ways of
aligning, top, bottom, left, right, for example.
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NOTE: You cannot do node editing on text objects and hatch objects; you can edit the
path’s nodes of curved texts.

4.17 Encoder distance

Select command “Encoder distance” in Draw Menu, the
Object List will display the encoder distance like Figure 4-68
shows.

“Encoder distance” is used to test the motion distance in
fly mark. Encoder parameters please refer “Instruction of
marking-on-fly”.
4.18 ExtAxis

4.19 Spiral

Figure 4-68 Encoder distance
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means the marking direction of the spiral lines

different type of spiral

Inside tight Average Outside tight
Pen NO: marking pen number
Min Radius:the most inside circle diameter
Min Spiral Pitch: min spiral distance on the middle warp
Max Spiral Pitch: max spiral distance on the middle warp
Spiral pitch Inc: increment of the spiral pitch
Outside Edge Numloops: marking times of outside circle
Inside Edge Numloops: marking time of inside circle
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Chapter 5 Modify Menu

Commands in Modify Menu will take easy operations on selected objects, such as
Transformation, Plastic, Curve Editing, Aligning, etc. (Figure 5-1)

Figure 5-1 Modify Menu

5.1 Array

Click “Array”, we can see the figure 5-2(a):

Figure 5-2-a Array dialog box（Rectangle）

Rectangle: The graph according to rectangle array
Circle: The graph according to circle array
The figure 5-2(a) is the Rectangle Array dialog box

：Set array’s row as marking precedence

：Bidirectional array

Array num: The row number
Array num: The column number
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Array: The space between two objects on X direction
Array: The space between two objects on Y direction
Calculate by offset distance: The space of the graphs is calculated by offset distance.

(Figure 5-3(a))

Figure 5-3（a）Calculate by offset distance Figure 5-3（b）Calculate by graph distance

Calculate by graph distance: The space of the graphs is calculated by graph distance.
(Figure 5-3(b))

If we select the array type is “Circle”, we can see the figure 5-2(b):

Figure 5-2-b Array dialog box(Circle)

: The graphs array is clockwise or anticlockwise.

Array number: The graph number.
Radius: The radius of the circle.
Start Angle: The angle between the starting graphs of the circle.
Angle: The angle between two graphs.

5.2 Transformation

When selected, a parameter setting box will appear as Figure 5-4 shows.



EzCad2UNI User’s Manual

73 All rights reserved

5.2.1 Move

: stroll Tool for moving objects
Position: the coordinates of the current selected object

datum mark. This function is the same as the Position which
is introduced in object label of properties toolbar in chapter
2.10.

: select a datum mark of an object

Relative Position: use relative coordinates

: Activate the modification

: This item is used to copy the

current selected object and move it into a new place.

5.2.2 Rotate

: rotate your object
When selected, a parameter setting will appear in the Transformation Setting Box as Figure

5-5 shows.
Angle: angle to rotate
Center: the coordinates of the current selected object’

datum mark

: Select a datum mark of an object

Relative Center: change the current coordinates into
relative coordinates

: Apply. Let the modification of

the current object active

: This item is used to copy the

current selected object and rotate it into a new place.

5.2.3 Mirror

Figure 5-4 Transformation

Figure 5-5 Rotate
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: mirror the current selected object
When select mirror command, a parameter setting box will appear as Figure 5-6 shows.
Scale: the zoom ratio of the X/Y size after being mirrored

: The current object’s vertical mirror

: The current object’s horizontal mirror

: select a datum mark of an object

: Let the modification of the

current object active

: This item is used to copy the

current selected object and mirror it into a now place.

5.2.4 Zoom

: zoom your objects
When selected, a dialog box will appear as Figure 5-7

shows.
Figure 5-6 Mirror
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Size: the size after zooming. This function is the same as the Size which is introduced in
object label of properties toolbar in chapter 2.10.

: select a datum mark of an object

: Let the modification of the

current object active

: This item is used to copy the

current selected object and zoom it into a now place.

5.2.5 Lean

: lean the current selected object
When selected, a parameter setting box will appear as

Figure 5-8 shows.

Angle: the angle the object leans

: select a datum mark of an object

: Let the modification of the

current object active

: This item is used to copy the

current selected object and lean it into a now place.

Figure 5-7 Zoom

Figure 5-8 Lean
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5.3 Plastic

When selected, a parameter setting box will appear as Figure 5-9 shows. Figure 5-10 shows
examples of the following three items.

: Joint two close intersect areas into one

: Shear a close intersect area contained in another

: pick up the intersect part of two close intersect areas

5.4 Distribution

Distribution is to several objects distribute in the workplace as considering regular. Eg: there
are 6 rectangles in the workplace, when click distribute, follow dialog window will pop-up:

Figure 5-9 Plastic Figure 5-10 Plastic 1. Original 2. Joint 3. Shear 4. Intersect
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left：Distribute left and right

based on the left line；

middle：Distribute left and

right based on the middle line；

distance：Distribute left and

right based on distance between two
objects；

right ： Distribute left and

right based on the right line;

top：Distribute up and down based on the top line;

middle：Distribute up and down based on the middle line;

distance：Distribute up and down based on distance between two objects;

bottom：Distribute up and down based on the bottom line；

Take fig 5-11 as example to introduce the usage and result of ‘distribution’, click and

，the result as fig 5-12:

Fig 5-12 （a）objects before distribution Fig 5-12（b）objects after distribution

Before ‘distribution’ (fig 5-12a), the distance between the center of each object is different,
and after ‘distribution’, distance between the center of each object is the same(fig 5-12b).

5.5 Curve Editing

Fig 5-11 distribution dialog window



EzCad2UNI User’s Manual

78 All rights reserved

1. Auto- Connect:
When selected, a dialog box will

appear as Figure 5-11 shows.
Auto-Connect Error:
If the distance between two

curves’ starting and ending points is
less than the parameter set, the two
curves will be jointed into one.
2. Break cross point:

When user click curve editing->break cross point, follow dialog window will pop-up as fig
5-14.

fig 5-14 break cross point

The length of cross point means the length of the cross line part that we designed, as fig
5-14,take follow fig 5-15 for example:

（a）before break cross point （b）after break cross point

Fig 5-15 result of break cross point

5.6 Align

Command “Align” will be available only when more than one object is selected in the
workspace. “Align” is used to align the objects users select on the two-dimensional plane. There
are several ways to align:

 Left: All objects align left.
 Right: All objects align right.
 Vertical:All objects align vertical.

Figure 5-11 Auto-Connect
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These three ways above only support to move objects on horizontal direction.
 Top: All objects align top.
 Bottom: All objects align bottom.
 Horizontal: All objects align horizontal.

These three ways above only support to move objects on vertical direction.
 Center: All objects align center. This way may cause moves on both horizontal and

vertical directions.

Note: The benchmark to align is according to the last object users select, and other objects
align behind it. If you select several objects by “Frame Select”, then the system will hardly
identify which is the last one, and this may cause unexpected alignment. It is strongly
recommended that you select the object which is to be the benchmark at the end when you
want to align several objects.

5.7 JSF font

5.7.1 The definition for the function of JSF font library.

JSF font is the dedicated font of EZCAD software; users can build up their own JSF fonts.

The file with “JSF” postfix is the proprietary font file of EzCad, every JSF font file has one kind

of font.

Fig 5-16

When the user click JSF font, system will show a dialogue as figure 5-17.
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Fig 5-17 JSF font
Then, let’s introduce the functions of various parameters and functions keys shown in the graph
above.
Before we use the function to create or modify our font file, we should learn more about the
characters aircraft JSF font structure. Click "Help" button to show the graph 5-18.

Figure 5-18 Help

Through Figure 5-18 we can see that, in addition to the width and height which stands for the
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graphic characters, the software also identify the font size on ‘Ascent height’, ‘Descent height’,
‘Left-side bearing’, ‘Right-side bearing’ etc, that is to say, if the figure we design which stands
for characters Q is in the grey scope as graphics 5-18 define, well, actually the “Q” EZCAD
identified is the area with the blue dotted line.
All of the graphic’s width, height, ‘Ascent height’, ‘Descent height’, ‘Left side bearing’, ‘Right
side bearing’ we designed can be amended by software.

jsf font name: The name of font needed to be established or modified.
Char of graph: The character that correspond with graphics in “Preview”.

Load char data: Loaded character data: Load the data of the character from the font library. Note:
The font library and characters are all already existing. Save char data: Replace the corresponding
characters with the forthright graph in “Preview”. If it’s the renewed characters, you should
save the graph in “Preview” in the corresponding data..

Scale X: The X-direction scale of the graph in “Preview”. Changing this parameter, we can
adjust the width of the graph we designed which can stands for the characters. The default value is
1. Increase it, graphics turns broad; reduce it, graphics gets narrowed.

Scale Y: The Y-direction scale of the graph in “Preview”. Changing this parameter, we can
adjust the width of the graph we designed which can stands for the characters. The default value is
1. Increase it, graphics turns broad; reduce it, graphics gets narrowed.

Offset dist Y: The Y-direction offset of the graph in “Preview”. The default value is
0.Increase it, graphics moves up; reduce it, graphics moves down. Left-side bearing: As the figure
5-18, namely the distance of the left frame of gray box and the left frame of blue box.

Right-side bearing: As the figure 5-18, namely the distance of the right frame of gray box and
the right frame of blue box. In Figure 5-18, we can see "update font file” and "Char kerning" two
functional buttons are disabled. Here we need to choose name of jsf font library, the functional

button is behind the input box. Function keys : the function keys pop "open" dialogue

->Select the name of font library we need to amend ->Clicking “OK” (there will indicate the
route of file).As follow figure 5-19.
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Figure 5-19 select a font file
Now, "update font file” and "Char kerning" two functional buttons are in valid state.
“Update font file”: Click this button-> "Character Attributes" dialogue as the figure 5-20.

Figure 5-20 font property

Font name: The name of character which Font library file saved.
Double char Width / Height: Such as double byte characters like Chinese, the width and height

of the character they correspond.
Single char Width / Height: Such as single byte characters like English and digit, the width and

height of the character they correspond.
Descent ratio: The percentage of height hereinafter the baseline accounting for the character ’s

standard height.
Can be hatched: Check it, means allow hatch the characters, or else, not allowed.
Char kerning: Click this button->"Char kerning" dialogue, as the figure 5-21.

Figure 5-21 char kerning

Input two characters: The two characters which need to adjust the space.
Char kerning: The space between the two characters that need to be adjusted, up arrow stands
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for increment, down arrow stands for convergence. Also can input digital directly.
Save kerning to file: Save the space to the Character style file.
5.7.2 Instruction for steps of establishing font library
Let’s take an example to show how to use the function of JSF character library.
Ex1 : Establish a font library named ezcad0521, and add character “a” to it.

Use the software to edit ‘a’ that we need to represent or import one and make graphics in
selected state. As figure 5-22.

Figure 5-22 draw the graph
Click "Modify" "JSF Fonts”, then shown a font dialogue box as figure 5-17. Click

button , and find ezcad2\font catalogue in the dialogue, input “EZCAD0521”, and then click

the button to indicate dialogue as the follow figure 5-23 .
Please note: the route of system fonts is ezcad2\font, so you must create in the folder a new

name of the file, otherwise the software will not fetch the file retrieval. Now the system will find a
file named "EZCAD0521" font in route: ezcad2\font, if not found, the system will lead a dialogue
to remind users whether establish the document or not. Click “ok” to establish EZCAD0521.jsf
document, then shown a dialogue “Character Attributes” as figure 5-18, after amending the
attributes, such as the height of double->character and single character, the width of double ->
character and single character, descent height hatch etc (Normally defaulting) ->click ‘OK’, then
the system have saved the document named "EZCAD0521, jsf” already.

Input character “a” into the corresponding character editing box, then amend the characters
ratio, offset distance and stay width is parametric to make the graphic to the suitable
position->Click the button: ’Save character data’. Now the pattern data has been saved to the
position where character ‘a’ corresponded. As figure 5-23.
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Figure 5-23save

Quit from JSF fonts dialogue- Restart the software. Establish a text object-Select “JSF font”in

the font list of Text attributes column-Select our new EZCAD0521 font-Input ‘a’ in the text

box-Click “Apply”. Then it could be edited out the graphics of characters ‘a’ we required. As

figure 5-24.

Figure 5-24 new character ‘a’

Ex2 Amend the character A in the file “EZCAD521”, then amend the character structure of
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whole font library.

1. Click "JSF fonts" under "modify" menu, then shown the JSF font dialogue, as the figure

5-17->Click , open the dialogue to find the route: ezcad2\font->Input “EZCAD0521”--

Click the button.

2. Input ‘a’ in the input field which the graphic corresponded, Click ‘Load char data’

button, then appeared in the preview box a graphic which is representative A. By amending the X

Y scale, offset distance and bearing to achieve the effect result we need. Then Click“Save Char

Data”button.

3. Click "Update font file" button, and shown a dialogue as figure 5-24. Here we can

amend the name of font, the height and width of double-character and single character, descent

ratio, hatch or not, etc.

4. Click ‘OK’->quit from JSF font dialogue->Establish a text object->Select “Single

font” in the list of ‘Text attribute’-> Establish the font entitled

“EZCAD0521”->Input ‘a’ in the text input.->Click “Application”. Then we can edit out the

amended character ‘a’ graphic.

5.8 Rsort

After choose this function, will show ,click left one
software will mark through Y direction, if click the second icon, mark direction will be X, if
click Reverse, all direction reversed

5.9 Trim

When choose it, will show one shears, and when move the shear to the line, will become blue
color, and then can cut the line
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Chapter 6 View Menu

The View Menu is used to set every option for view in the EzCad2 window, as Figure 6-1
shows.

Figure 6-1 View Menu

6.1 Zoom

The Toolbar of the zoom Menu is , and there are seven
types for different requirements.

: This item is used to fill the whole view area with the appointed area. Users may use
mouse to select rectangle area to zoom in. If pressing the right button of the mouse, the current
view will zoom out for one time with the mouse pointer’s position as the center; and if pressing
the left button of the mouse, the current view will zoom in for one time with the mouse pointer’s
position as the center.

: To move the current view

: Zoom in

: Zoom out

: Fill the whole view area with all the objects

: Fill the whole view area with only the selected objects



EzCad2UNI User’s Manual

87 All rights reserved

: Fill the whole view area with the whole workspace

6.2 Ruler / Gridding / Guide Line

There are Horizontal Guage, Vertical Guage, Gridding and Guide Line for selection.

6.3 Snap Grid

This item is used to automatically put the dots you draw on the grid.

6.4 Snap Guide Line

This item is used to make objects approach to guide lines automatically when moving the
object.

Fig 6-2 snap guide line

6.5 Snap Objects

This item is used to snap an object’s top, center, nodes, circle center, intersect points, etc.

6.6 System Toolbar / View Toolbar / Draw Toolbar / Status Bar / Object List

Toolbar / Object Properties Toolbar/ Mark Parameter Toolbar

EzCad2 supports many toolbars to achieve different functions. Toolbars can be either
displayed or hidden by selecting corresponding options in View Menu; and also the Status Bar can
be displayed or hidden, either. When there is a “√” selected in front of the submenu, the
corresponding toolbars or Status Bar is visible, and if not, they are hidden.

6.7 IO state

Check current input and output state, follow fig 6-3
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Fig 6-3 IO state
Gray means low level, green means high level.
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Chapter 7 Special

7.1 Change text

Click change text, follow dialog window will pop-up, as fig 7-1.

Fig 7-1 change text interface
The content under ‘text’ is to be replaced, the content under ‘change to’ is that after

replace. Fig 7-2b is the result after operate fig 7-2a as the method in fig 7-1.

Fig 7-2a content before replace Fig 7-2b content after replace
The name of the text is replaced, but the content of the text is not changed.

7.2 IPG Setting

Click IPG Setting in ‘special’ menu, the follow dialog will pop-up, Fig.7-3. It connects
computer and laser through serial line for series of IPGM laser, and the laser can send the status
signal of themselves to the software, like temperature, power state.
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Fig.7-3

After press the button of connect, all lights before the laser’s status signal will become green, and
this express the state is normal. You can change the pulse width of laser’s high between 4 and

200ns .And can change frequency between 1and

1000KHZ in parameter.
7.3 SN TEXT
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Chapter 8 Laser

Laser menu mainly aims at expansion axis control, it includes following modules. As is shown
in Figure 8-1:

Figure 8-1

8.1 Rotary marking

The file AngleRotate.plg under the directory EzCad2\plug is the module that fulfills rotary
marking. When EzCad software begins to run, it will look for all files with extention plg under
directory Ezcad/plug. The menuitem rotary marking will be enabled if the file exists in plug
directory.

Figure 8-2 Figure 8-3

Coordinate value of axis Z stands for rotary angle in rotary marking. The software will rotate
the workpiece first before marking. So we should set a rotation angle to each object when we draw
objects in work space, and place each object in the middle of the work space (as shown in Figure
8-3).

The configuration parameter is shown in the below Figure 8-4:
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Figure 8-4 Configuration parameter dialog box

Reverse: Reverse the move direction of the expansion axis.
Pulses per round: The pulse numbers each round that the expansion axis rotating. We can

calculate it through following formula:
X=（360/N）* n

Thereinto:
X denotes Pulses per round.
N denotes step angle of step motor.
n denotes micro-step set by step motor driver.

Min speed: the minimum rotary speed of expansion axis.
Max speed: the maximum rotary speed of expansion axis.
Acc. time: Acceleration time needed when expansion axis moves from minimum speed to

maximum speed.
Goto start position after finished: The expansion axis will go back to the initial position

after finishing marker.
Speed：The speed of the axis going back to the initial position after finishing marker.
Zero: Whether current expansion axis has zero-switch input signal. Without zero signal, the

software can’t build up an absolute coordinates. Marking a set of parts, we need make every mark
at the same position. To mark figure at the same position each time, the system takes current
expansion axis as a default original point before marking in the case of without zero signal. After
processed a part, the system moves the axis to the original position automatically. In this way,
each part will be marked in the same position.

If zero is enabled, zero switcher will be found automatically. The software creates an
absolute coordinate after Finding out zero switcher. If the system failed to find out zero switcher,
expansion axis cannot be used until the appointed time set by parameter zero time out has
expired.
Note: The switcher used for zero signal must be normal-open type and the signal should be
connected to input port 0.
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Speed of Go Zero: The move speed when expansion axis go zero.
Zero time out: The system will present “Zero time out” when failed to reach the position

where the zero switcher was assembled within the appointed time.
Accurate Zero：When it is selected, the axis must gives three zero signals in go zero process;

and it isn’t selected, the axis only need one signal.
Correct axis origin: The current expansion axis go zero and reset coordinates.

The following example explains how to use this module.
Requirement: Mark three letters a、b、 c on the surface of a column, the angle intervals

between two adjacent letters is thirty degree.
Step 1: Draw letter a in workspace. Set coordinate Z to 0 and click Apply button. Click put

to origin button on toolbar to put the letter a to the center of workspace. As is shown in Figure
85-1.

Figure8-5-1 setting of letter a Figure8-5-2 setting letter b Figure8-7-3 setting of letter c

Step 2: Draw letter b in workspace similarly. Set coordinate Z to 30. Then click Apply button and
click put to origin button, as is shown in Figure 8-5-2.
Step 3: Draw letter c in workspace and set coordinate Z to 60. Then click Apply button and click
put to origin button. As is shown in Figure 8-5-3.
Step 4: Click menu item Rotary marking. The dialog box shown in below Figure 8-5-4 will
popup.
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Figure 8-5-4 rotary marking dialog box

Step 5: Click button Param(F3) or press key F3 to setup configuration parameters.
Step 6: Click button Mark(F2) or press key F2 to start the job.

8.2 Rotary marking 2

Except the new option 360 degree mark, the others parameters in Rotary marking2 is the
same as those in Rotary marking, as is shown in Figure 8-6.

Figure 8-6 Rotary marking2 interface
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360 degree mark: Selected to mark the figure on the column evenly.
Total num: The count of figure that will be marked on the column with evenly interval.
If we don't check 360 degree mark, Increment button will show.
Increment: The angle that the column should rotate after mark each figure. It is the angle interval
between two adjacent figures.

Application 1: Draw the figure need to mark on the workspace and place it to the center. Make
sure that the coordinate Z is zero. Select 360 degree mark and set Total num to 10, and then click
Mark button. The whole mark procedure is that: Firstly, mark the figure; Then, the column rotate
36 degree(360/10) , and mark the figure again, until total 10 figure have been mark on the column
evenly.
Application 2: Draw the figure need to mark on the workspace and place it to the center. Make
sure that the coordinate Z is zero. Uncheck 360 degree mark. Set Total num to 10 and
incremental to 45. Click Mark button to start. The mark procedure is that: Firstly, mark the figure;
Then, the column rotate 45 degree, and mark the figure again, until total 10 figure have been mark
on the column.
Note: Only expansion axis A can be used in Rotary marking module and Rotary marking2
module. Please take care when connecting the wire.
The following example explains how to use this module.
Requirement: Mark the same letter a on the column evenly. The total count is five.
Step 1: Draw letter a in workspace. Click Apply button after setting font and size.
Step 2: Click menuitem Rotary marking2 and the dialog box shown in Figure 8-8 popup.
Step 3: Select 360 degree mark and set Total num to five.
Step 4: Click button Mark (F2) or press key F2 to start the job.

8.3 MultiFileMark

“MultiFileMark” module is able to mark repeatedly different *.ezd files, avoiding changing
the files. That function menu is shown in figure 8-36:

Figure 8-36
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Figure 8-37

Add: Add .ezd files. The dialog box pops up as Figure 8-38 after click “add” button. Setting
I/O control conditional for files, and automatically mark files when board accept the IO signal in
mark status.

Figure 8-38

Delete: delete files.
Prev, Next: change the order of files.
Modify: change file selected and IO control conditional.
If click the name of files, show the file content in the multifilemark dialog box right. If

double click the name of files, open the file, and can change the content and parameter. Mark the
revised files after press save.

Save: save choosing files and setting IO control conditional to *.mfd.
Open: open *.mfd files.
Set IO control conditional, press mark, then board check the signal, if the signal is the same

as setting, the files with the setting will be marked. If the signal accord with some files, the file in
the front will be marked.
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Generally speaking, software accepting signal is the level signal, and press mark button, the
dialog box pops up as Figure 8-39. When the signal accord with setting, shows the figure 8-40,
with the name of file in the following of box.

Figure 8-39

Figure 8-40

If must the accepting signals be pulse signals, should set IO port that doesn’t show in figure
8-38 in start mark IO. For example, port 0-3 show in figure 8-38, should set other port in start
mark IO, as port 6. Press mark , then pop up figure8-41.When the board accept the start mark IO
and setting IO control conditional at the same time, the files will be marked only one time.

Figure 8-41

8.4 Power Ruler

The function of is Power Ruler mainly uses for to design each kind of scale, turn on EzCad 2 and
select “PowerRuler ” in the laser menu, as is shown in Figure 8-22:
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Figure 8-22

Click “Power Ruler” the mark dialog box is shown in Figure 8-23：

Figure 8-23

New File：The software will close the documents which you are editing and meanwhile
create a new file

Open File：When click “Open”, the software will pop an open-file dialog to ask you select
the file you want to open

Save File: save the current file to disk.
Save as: save the current file to disk by another name.
Export to WS: export the file to the software workspace.



EzCad2UNI User’s Manual

99 All rights reserved

Edit: Revision the content.
Delete：Delete the content.
Click “Add” presenting to edit the ruler, following dialog box shown in Figure 8-24：

Figure 8-24 Make ruler dialog box

Type:
Line： The current parameter is the line parameter value
Value：The current parameter is the value parameter value
Text：The current parameter is the text parameter value
VectorFile：The current parameter is the vectorfile parameter value

Text：
Rotate: the angle of the text revolving

Hatch:
Pen No.：This item indicates that objects with selected pen’s number will be marked.

Graduation Num: The total graduation numbers need to be marked
Start Graduation: Set the position of start marking graduation
Increment pos: the space between two neighboring lines
Line width: Set the width of the line
Start point: Set start point of the line
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End point: Set end point of the line
Start value: Set start value of line
Inc. value: Set Inc. value of the line
Dot bit count：Set dot bit count of the line, for example：set the dot bit count as 2，the value may

become

0 not show tail zero：0 did not show behind 0
Text: show the text information on the ruler. We can see the figure when we select “Text”

， We can compilation the

text content in the white frame
Vector File: Show the information of the vector file on the ruler
Scale X: width of the vector file
Scale Y: height of the vector file
Angle: the angles between vectorfile and X axis
For example: make a Straight ruler long thirty centimeters（three hundred millimeters）:
After set well the External Axis, select Straight ruler, click “Add” then the dialog box popup
shown as Figure 8-24 to set the Line

Set the longest degree ten: There are thirty one degree ten lines from zero to three hundred，
from the start graduation of the workpiece， the space is ten millimeters， the length is seven
millimeters，so as to the “Graduation Num” is thirty one，“Start Graduation” is 0，“Increment pos”
is ten，“Start point” is（zero，zero），“End point” is（zero，seven）；

Set the degree five : There are thirty degree five lines from zero to three hundred，from five
millimeters of the start graduation，the space is ten millimeters，the length is five millimeters，so
as to the “Graduation Num” is thirty，“Start Graduation” is five，“Increment pos” is ten，“Start
point” is（zero，zero），“End point” is（zero，five）；

Set the degree one : There are two hundred and forty degree one lines from zero to three
hundred，in order to avoid with degree ten and degree five superposition，degree one lines need to
set four times：from one millimeter，two millimeters，three millimeters，four millimeters in turn，
the space is five millimeters，the length is three millimeters, so as to the “Graduation Num” is
sixty，“Start Graduation” is one, two, three, four in turn，“Increment pos” is five，“Start point” is
（zero，zero），“End point” is（zero，three）；

Set the Value: select “Value”，only input the value of degree ten lines，so as to the
“Graduation Num” is thirty one，“Start Graduation” is zero，“Increment pos” is ten，“Start value”
is zero，“Inc. value” is ten，“Start point” is（zero，zero），“End point” is（zero，eight）；

Set the unit of the ruler: select “Text”，“Graduation Num” is one，input “Start Graduation”
and “Start point” according to actual situation，and inputs the text content which can show.

At last, the figure 8-23 turns to:
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Now, the thirty centimeter Straight ruler completed.
The method of make Ring ruler or Disk ruler: at first, click “Param” the dialog box popup

shown as Figure 8-25 to set the External Axis
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Figure 8-25 configuration parameters of expansion axis

Straight ruler/Ring ruler/Disk ruler: The ruler's type need to mark currently，choose is enable
Part diameter: The workpiece accurately diameter of the “Ring ruler” or “Disk ruler”.
Reverse: Reverse the move direction of the expansion axis.
Pulses per round: The pulse number of expansion axis motor makes a circle needed. We can
count pulse number per revolution X through following formula:

X = (360 / N) * n
X refers to pulse number per round;
N is the pace angle of electric motor;
n refers to subdivision number of driver;
Minimum speed: The minimum speed of expansion axis;
Maximum speed: The maximum speed of expansion axis;
Accelerate time: The time of expansion axis need when it moves from minimum speed to

maximum speed.
Go to start position after finish: Expansion axis returns to start position after finishing

processing;
Speed：The speed of the axis going back to the initial position after finishing marker.
Zero: Whether current expansion axis has zero-switch input signal. Without zero signal, the

software can’t build up an absolute coordinates. Marking a set of parts, we need make every mark
at the same position. To mark figure at the same position each time, the system takes current
expansion axis as a default original point before marking in the case of without zero signal. After
processed a part, the system moves the axis to the original position automatically. In this way,
each part will be marked in the same position.

If zero is enabled, zero switcher will be found automatically. The software creates an
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absolute coordinate after Finding out zero switcher. If the system failed to find out zero switcher,
expansion axis cannot be used until the appointed time set by parameter zero time out has
expired.

Speed of Goto Zero: The move speed when expansion axis go zero
Accurate Zero：When it is selected, the axis must gives three zero signals in go zero process;

and it isn’t selected, the axis only need one signal.
Correct axis: The system will present “Zero time out” when failed to reach the position

where the zero switcher was assembled within the appointed time.
Return “Power Ruler”, similarly the method of make straight ruler to complete the graphics.

See the figure 8-26 about the Disk ruler:

Figure 8-26 the Disk ruler

8.5 Ring Text Mark

Ring text mark means mark text on ring, can mark on out surface of the ring, also can mark
on inside surface of the ring, out surface mark is normal ring mark, and inside surface mark need
the help of rotary marking and slant rotary axis together, follow picture shows the interface of the
ring text mark.
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Our surface ring mark runs same with ring mark, but the inside surface mark is different,
because the rotary axis who hold the ring will be slant, so the inside surface will also slant, so will
effect the focus and calibration(ring text mark doesn’t support 9 points calibration)

So with this plug, we mainly shows inside surface ring mark, when inside surface ring mark,

we need to click

Also need to open two axis function, one for rotary, the other for slant, because of the slant
axis, so the focus length value what input to the software will change a little, firstly we make the
focus point on center of the ring.

Diameter of the ring:：when outside mark, its from center to the out surface of the ring. When
inside mark, its ring center to the inside surface of the ring. Software will calculate according to
these value.
Depth of the ring：the distance from outside to inside of the ring surface.
L：distance from the ring installation surface to the rotate center
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Angle：the slant angle of the rotary
Refresh：after updating the marking parameter, click it, let the software to read new parameters.
3 calibration： similar with the inside calibration, during mark, use it to calibrate the marking
distortion.
Outside mark: in the F3 parameter, can choose X and Z in ID, during mark, software will
split the picture in X direction
1，rotary axis and z axis go to zero
2，find the focus
3，set ring mark parameters then refresh
4，calibration
5，mark
Inside mark:in the F3 parameter, can choose X and Z in ID, during mark, software will split
the picture in X direction
1，click inside ring mark
2，rotary axis and z axis go to zero, we suggest for z axis, use zero offset to find the focus.
Zero offset: current axis arrive at the zero point, then move some distance to find the focus.

3，set ring mark parameters and refresh
4，calibration
5，mark
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8.6 Rotary mark

Click ‘Rptary mark’, follow dialog window will pop-up

Figure 8-27

Part diameter: click it, and fill in part diameter.
Focus length: click it and fill in focus length of F-θlens.
Note: the two parameters effect marking result directly.

Two split models:
1. Mark selected: control marking size through configuring split size, don’t click ‘mark by split

line’ at the same time, or the software will split as ‘mark by split line’
2. Mark by split line: click it, software will mark as ‘mark by split line’, click left keyboard

twice to draw split line, click right keyboard near the split line to cancel the split line. The
direction of the split line is the same with rotary axis.
‘axis step’: The move distance each time when the key Ctrl and arrow key

Left/Right/Up/Down was pressed together. Press key PageUp/PageDown to increase/decrease
the distance.

Press Ctrl+Left to move left and Ctrl+Right to move right for expansion axis X.
Press Ctrl+Up to move up and Ctrl+Down to move down for expansion axis Y or axis Z.

Part: The part count that has been marked. Press the button R on the rightwards will reset the part
count.
Total num: The total count need to mark. When the parts have been marked reach the Total num,
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software will stop it automatically.
Continues: Repeatedly mark the figure until stop it manually.
Mark Selected: Only those figures selected will be marked.
Click parameter, this dialog window will pop-up

Figure 8-28

The definition of each parameter:
Enable: Enable current expansion axis.
ID: The current expansion axis will be used as axis X/Y/Z.

ID is X, the figure will be split in direction X to mark.
ID is Y, the figure will be split in direction Y to mark.
ID is Z, the expansion axis will move to the appointed position to mark.

Pulses per round: The pulse numbers each round that the expansion axis rotating. We can
calculate it through following formula:

X=（360/N）* n
Thereinto:

X denotes Pulses per round.
N denotes step angle of step motor.
n denotes micro-step set by step motor driver.

Min coor: The minimum logical coordinates of expansion axis. When the object’s coordinate
of the expansion axis is smaller than the minimum coordinates, the warning message will popup.

Max coor: The maximum coordinate of expansion axis. When the object’s coordinate of the
expansion axis is greater than the maximum logical coordinates, the warning message will popup.

Min speed: the minimum rotary speed of expansion axis.
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Max speed: the maximum rotary speed of expansion axis.
Acc. time: Acceleration time needed when expansion axis moves from minimum speed to

maximum speed.
Goto start position after finished: The expansion axis will go back to the initial position

after finishing marker.
Speed：The speed of the axis going back to the initial position after finishing marker.
Rotation axis: Select it, it's indicates that current expansion axis is rotation axis. Moving

manner is rotation; otherwise, it indicates flat content processing or Z axis locating process.
Gear ratio: Electric motor connecting axis, the reducing ratio is one. If there are reducing

setup, the reducing ratio is reducing setup ratio.
Part diameter: The workpiece need to mark currently. If expansion axis is rotation axis, part

diameter, an important parameter to count move distance, must fill in accurately.
Zero: Whether current expansion axis has zero signal. When expansion axis hasn't enabled

zero signal, it can’t set up an absolute coordinates. Therefore, marking a set of parts require
adjusting site to make every processing stay in the same site. So, the system takes expansion axis
as default origin point before processing. After processing a workpiece, the system will move
expansion axis back. In this way each workpiece will process in the same site.

Speed of Go zero: the moving speed of expansion axis looking for zero signal.
Zero time out: Set the time of expansion axis finding zero point. If it overruns it, the system

will present “overtime”.
Accurate Zero：When it is selected, the axis must gives three zero signals in go zero process;

and it isn’t selected, the axis only need one signal.

8.7 Rotate Text Mark

“Rotate Text Mark”：can solve the question the hatch lines and text independent mark when
rotate mark the hatch text，they are cannot superposition，using this function，the hatch lines and
text are marking together.

8.8 Split mark 2

“Split mark2” module is able to split joint big content. We can either choose an expansion
axis to be X direction split joint, or choose two expansion axes to be XY direction split joint
respectively. That function menu is shown in figure 8-29:

Figure 8-29 “Split mark 2” item
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Its operation dialog box is shown as follows:

Figure 8-30 “Split mark 2”dialog box

Distance: The move distance each time when the key Ctrl and arrow key
Left/Right/Up/Down was pressed together, or click arrow. Press key PageUp/PageDown to
increase/decrease the distance.

Press Ctrl+Left to move left and Ctrl+Right to move right for expansion axis X.
Press Ctrl+Up to move up and Ctrl+Down to move down for expansion axis Y or axis Z.

Split size: The marking size before rotation each time. When marking the figure on the column,
we always split the figure into many strips to keep the focus point as the same. Mark one strip,
then rotate the column, and mark the next strip, one by one until the whole figure was processed.

Note: The split size is very important for the whole figure. It has great influence on the time
and the effect.
Part: The part count that has been marked. Press the button R on the rightwards will reset the part
count.
Total num: The total count need to mark. When the parts have been marked reach the Total num,
software will stop it automatically.
Continues: Repeatedly mark the figure until stop it manually.
Mark Selected: Only those figures selected will be marked.
Force split: Divide the whole figure into equal parts neglecting the size of each object.

Figure 8-31 is the case without Force split selected while Figure 8-32 is the one that enable
Force split. The split size in two figures is 18mm.
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Figure 8-31 Marking without Force split selected

Figure 8-32 Marking with Force split selected

In Figure 8-31, the left two circles smaller than split size and be marked without split. The
circle on the right is greater than split size and was divided into three parts to mark. Without force
split selected, the objects smaller than split size will be marked without split and those greater
than split size will be divided to mark according the split size.

In Figure 8-32, the whole figure (three circles) was split into equal parts to mark. The object
on the split border will be divided even its size is smaller than split size.
Force all split: When there are multiple objects in the object list, all objects will be processed as
a whole one according to the split size. The objects smaller than split size will be marked first, the
rest that exceed split size will be divided to mark.
Mark by split line: after click it, will not split according to fixed size, will split according to the
split lines.

Click “parameter” button to setup parameters of expansion axis. The dialog box pops up as
Figure 8-33.
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Figure 8-33 configuration parameters of expansion axis

The definition of each parameter:
Enable: Enable current expansion axis.
ID: The current expansion axis will be used as axis X/Y/Z.

ID is X, the figure will be split in direction X to mark.
ID is Y, the figure will be split in direction Y to mark.
ID is Z, the expansion axis will move to the appointed position to mark.

Pulses per round: The pulse numbers each round that the expansion axis rotating. We can
calculate it through following formula:

X=（360/N）* n
There into:

X denotes Pulses per round.
N denotes step angle of step motor.
n denotes micro-step set by step motor driver.

Min coor: The minimum logical coordinates of expansion axis. When the object’s coordinate
of the expansion axis is smaller than the minimum coordinates, the warning message will popup.

Max coor: The maximum coordinate of expansion axis. When the object’s coordinate of the
expansion axis is greater than the maximum logical coordinates, the warning message will popup.

Coordinate value has relationship with effective move space and move direction of the the
worktable. eg:
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Fig 1

As fig1, the length of the work table is 200mm, move direction is from left to

right, origin point is on left side. The effective moving distance is 200mm, so Min

coor is -200, Max coor is 0.
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Fig 2

Move direction is from right to left, origin switch is on right side, effective

moving distance is 200mm, so Min coor is 0, Max coor is 200.

If the origin point is in other position, please consider it accordingly.

Min speed: the minimum rotary speed of expansion axis.
Max speed: the maximum rotary speed of expansion axis.
Acc. time: Acceleration time needed when expansion axis moves from minimum speed to

maximum speed.
Go to start position after finished: The expansion axis will go back to the initial position

after finishing marker.
Speed：The speed of the axis going back to the initial position after finishing marker.

Rotation axis: Select it, it's indicates that current expansion axis is rotation axis. Moving
manner is rotation; otherwise, it indicates flat content processing or Z axis locating process.

Gear ratio: Electric motor connecting axis, the reducing ratio is one. If there are reducing
setup, the reducing ratio is reducing setup ratio.

Part diameter: The workpiece need to mark currently. If expansion axis is rotation axis, part
diameter, an important parameter to count move distance, must fill in accurately.

Zero: Whether current expansion axis has zero signal. When expansion axis hasn't enabled
zero signal, it can’t set up an absolute coordinates. Therefore, marking a set of parts require
adjusting site to make every processing stay in the same site. So, the system takes expansion axis
as default origin point before processing. After processing a workpiece, the system will move
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expansion axis back. In this way each workpiece will process in the same site.
Speed of Go zero: the moving speed of expansion axis looking for zero signal.
Zero offset: The leave distance of current expansion axis after finding out zero signal.
Zero time out: Set the time of expansion axis finding zero point. If it overruns it, the system

will present “overtime”.
Accurate Zero：When it is selected, the axis must gives three zero signals in go zero process;

and it isn’t selected, the axis only need one signal.
Scale compensation: It refers to the scale coefficient of corresponding move distance in

expansion axis. Adjust this parameter can remove separation and superposition in connection.
Space compensation: It refers to reverse space compensation, making up for sapce error

between gear when moving.
Shear compensation: When machine make bigger error ratio, shear phenomena will be

created during flat marking. Adjust this parameter can remove it.
When all parameters are set, you can click “mark” to process.
Note: 1. Use Corfile.exe to make whole linearity correction, making sure the consistency of

effect.
2. Table level, stable electric rotation and nice light mode are the keys for marking best

effect.

Special pos button can set the position that the motor moves to before mark. Hitting “Special
position” button and set appointed position coordinates. Then, hit “Special motion” button and
choose ‘Go to special position’, the motor will go to the position you set. As is shown in figure
8-34, figure 8-35:

Figure 8-34 Figure 8-35

8.10 ProjectMark

User can change the shape of the marking object in the software according to the shape of the
part, to make sure the marking result will not be distorted on the surface of the cylinder.
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Part diameter：left keyboard click on it, will pop up and dialog to input diameter of the part.
Focus length: left keyboard click on it, will pop up and dialog to input focus length of the F-θ

lens.
Note ：the 2 parameters effect the marking result directly

：means the relationship between the scanhead and the curved surface
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Chapter 9 Help

9.1 About EzCad2

An “About EzCad2” dialog box will appear if users select command “About” as Figure 9-1
shows. This box will display some information about the software, for example, the edition, the
user authorized and the copyright. User’s name will also be included in the dialog box.

Figure 9-1 about EzCad2
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Chapter 10 Marking

Figure 10-1 is the Marking Properties Table.

10.1 Pen List

In EzCad2, every document file has 256 pens,
0 to 255 numbered, and they are located in the top
of the Marking Properties Table. Each pen is
corresponding to a group of marking parameter and
the parameter base’s name is after the color.

: This item indicates that objects with
selected pen’s number will be marked. Users may
customize the color by double-clicking the color
sticker.

: This item indicates that the current object
has not been marked with a pen’s number, and it
will not be marked.

Color: the current pen’s color
Apply Parameter Button: The buttons show as

Figure 10-2
When pressed the button, the pen number of

the current object will be changed to the one that
the color stands for.

When pressing the right button of the mouse, a
shortcut menu will appear as Figure 10-3 shows.

Figure 10-2 Button to apply parameters Figure 10-1 Marking Properties Table
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Figure 10-3 Shortcut Menu

10.2 Marking Parameter Base

Marking Parameter Base is a base filled with all marking parameters which have been set by
users already. Figure 10-4 is a Marking Parameter List.

YAG: YAG indicates that the current Marking Parameter is for YAG laser machine, and if not,
it is for CO2 laser machine.

Select param from library: When press this button, a dialog will pop up as figure 10.2-1
shows. We can save the
parameters to disk files, or
to delete parameters from
files.

Curr param Save As:
“Curr param Save As” is
used to name the current
marking parameter to disk as
another parameter base’s
name.

Delete: to delete the
current parameter base
name.

Apply to Default: save all
the current parameter to
“default” parameter base name

Loop count: loop times to mark an object
Speed: the current marking speed
Power / Current: In CO2 mode, this item indicates the power percentage of the current

marking parameter, and 100% refers to the biggest power of the laser equipment. In YAG mode,
this item indicates the current of the Q-switch.

Frequency: the laser machine’s frequency in the marking parameter
Q pulse Width: the high-level’s time of the Q pulse if the laser equipment is Q-switch YAG

laser machine
Start TC: When the scanhead has to execute a mark command, the scanner mirrors first have

to be accelerated up to the defined marking speed. In the beginning of the movement, the laser
focus moves very slowly which may result to burn-in effect at the start point. To avoid this, We
insert a delay (Start TC) at the beginning of each mark command. When the laser eventually turns
on, the mirrors have already reached a certain velocity. However, if this value is too large, the first
part of the vector will be cut off. Also negative value is supported.

Laser Off TC: The delay time of the laser shutting down after marking finished. Proper time
can wipe off the burn-in effect at the end. This value cannot be negative.

Figure 10-4 Marking Parameter Base List
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End TC: The End TC parameter is used to control how long the software will wait at the
end of a series of vectors. The wait is required because the software is always "ahead" of the
hardware and must wait for the hardware to catch up. This delay applies to the end of all vectors
in which the laser is to be turned off after execution.

Polygon TC: the Polygon TC parameter is used to control how long the software will wait
at vector connection points. The wait is required due to the lag time between the software/DAC
position and the actual hardware/mirror position. This timer applies to all vectors whose endpoint
is also the start point of the next vector (polygon connection points). In other words, this timer
applies to end of all vectors in a series of connected vectors, except for the last one (the end of last
one is controlled by the End TC parameter). The three connected points in a square or the
intermediate connection points in a polyline circle are examples of points the Polygon TC
parameter can effect. The starting point of the square is controlled by Start TC parameter. The
last corner of the square is controlled with the End TC timer.

Clicking “Advanced” will prompt an advanced parameter dialog box as Figure 10-5 shows.

Fig 10-5
Jump Speed: set a jump speed of the scanner for the current parameter
Min jump delay/Max jump delay:set jump delay
Max delay TC:set longest time that make sure good jump result
Galvo will execute new command after a while when stop jump. The actual delay include two
situation:
Jump delay=Max jump delay(when jump distance longer than max delay TC)
Jump delay = (Jump distance/max delay TC)*(Max Jump Delay-Min Jump Delay)+Min
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Jump Delay (Other situation)
Eg: when max delay TC is 10mm,Min jump delay is 100us,max jump delay is 500us, if actual
jump distance is 12mm,then jump delay is 500us.if actual jump distance is 5mm,jump
delay=5/10*（500-100）+100=300us
Enable optimize mode:open optimize mode
Start length:acceleration distance when start marking
End length:acceleration distance when stop marking
Break angle:set break mark angle

End compensate: Only when in high-speed operation or this parameter need not to be set.
This parameter is used to mark a little bit more as an ending increment at the end of an operation.
Negative value is supported.

Acc Distance: In those applications that require laser marking without variation of intensity,
we have to add an accelerated segment before the start point to reach the homogenous marking
results.

Point Time: This parameter is used to set the marking time if there are dot objects.
Vector point mode/Pulse per point: Marking the vector graph using point mode, and force

the pulse number while marking each point
YAG optimize mode: While marking on the high reflection material using YAG laser,

optimize the hatch arithmetic. Note: the function is used to resolve the irregular lines when
marking on the high reflection material using YAG laser. If you want to use this function, you
must connect the PWM signal to the pulse modulate signal of the Q-switch.

Now let’s take it into practice:

Mark a rectangle with size 40×20 and fill it with the following parameters: Mark Contour/
Edge offset=0 / Line Distance =1.0 /Hatch Angle= 0 / Unidirectional hatch

Set the marking parameters like this:

Parameter Name: XX ---- the name users customize (easy to understand it’s means.);
Loop count: 1;
Marking Speed: XX ---- the speed users need;
Jump Speed: XXX ---- the jump speed users customize (It is suggested to use 1200 –2500.);
Power Percentage: 50%;
Frequency: 5KHZ;
Start TC: 300;
End TC: 300;
Polygon TC: 100;
Jump Position TC: 1000;
Jump Distance TC: 1000;
End compensate: 0;
Acc. Distance: 0;
There may be several results to mark this hatched rectangle.
Case #1: The hatch-lines and the border are separated. (Figure 10-6) This is because the Start

TC Value is too big, and it needs to be smaller.
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Figure 10-6 Case #1 Figure 10-7 Case #2

Case #2: The hatch-lines and the border are intersected (burn-in effect). (Figure 10-7) This is
because the Start TC Value is too small, and it needs to be higher.

Case #3: Uniform result. (Figure 10-8)

Figure 10-8 Case #3 Figure 10-9 Case #4

Different manufacturers use different Laser sources and scanner (gavlo), so the performances
are also different. Sometimes when however users modify the Start TC, the hatch-lines and the
border cannot be superposed. Here users need to set the Acc Distance Parameter (Values from
0.05 to 0.25). But this may cause the 4th case: the hatch-lines are beyond the border, as Figure
10-9 shows. Users may increase the Start TC Value or lower the Acc Distance Parameter, and if
the two parameters are adjusted well, there will be a perfect result.

 Adjust End TC:
Still mark the hatched rectangle mentioned above
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Here are three possible cases about the hatch-lines and the border’s relative positions.
Case #1: The fill-lines and the border are separated, as Figure 10-10 shows. This is because

the End TC is too short, and users need to raise it.

Figure 10-10 Case #1 Figure 10-11 Case #2

Case #2: Burn-in effect as Figure 10-11 shows. This is because the End TC is too long, and
users need to shorten it.

Case #3: Perfect result as Figure 10-12 shows.

Figure 10-12 Case 3 Figure 10-13 Case 4

Different manufacturers use different Laser sources and scanner(gavlo), so the performances
are also different. Sometimes when however users modify the End TC, the hatch-lines and the
border cannot be superposed. Here users need to set the End Compensate (Values from 0.05 to
0.25). But this may cause the 4th case: the hatch-lines are beyond the border, as Figure10-13
shows. Users should lower the End Compensate to reach the perfect result.
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 Adjust Jump Position TC | Jump Dist TC :
Below is the adjust steps:
Set the two Jump TC items’ values (Position TC value and Distance TC value) as 0 and then

mark the rectangle.
If the start segment and ending segment of the hatch-line are bent, users need to increase the

two Jump TC’s values until there is no bend appearing.
Note: The Jump TC is too big may influence marking efficiency. The scanner (gavlo)

have better performance, the lower the two Jump TC’s value is.

 Adjust Polygon TC:
If mark a rectangle with size 40×20, you may find three possible results about the rectangle’s

corners:
Case #1: As Figure 10-14 shows, it is changed into arc angle which should be right angle, and

this is because the Polygon TC is too short, here users need to raise the value.

Figure 10-14 Case #1 Figure 10-15 Case #2

Case #2: As Figure 10-15 shows, although the right angle is what it should be, the corner of
the angle is heavy marked, and this is because the Polygon TC is too long, here users need to
shorten the value.

Case #3: As Figure 10-16 shows, it is right angle and there is no heavy marking. This is the
result we want.

Figure 10-16 Case #3
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When finish setting these parameters already, you may start to mark. It is recommended that
users had better not modify the parameters which have been adjusted well. If they were changed,
the result would be changed too.

Users can use the same way to set other parameters and save them in the parameter list. By
doing this, users can reduce the repeated works and raise the work efficiency.

10.3 Mark-Control Bar

The Mark-Control Bar is located at the bottom of the main interface window, as Figure 10-17
shows.

Figure 10-17 Mark-Control Bar

Light: This item is used to mark the frame of the object without laser output so that users are
convenient to orient the workpiece. This function is available in those laser machines which have
guide light.

Key “F1” is the shortcut key of this function for guide light show.

Mark: to execute marking

Key “F2” is the shortcut key of this function.

Continuous: mark the objects repeatly until user stop the mark
Mark Selected: only those selected objects would be marked
Part: the total counts that the mark command has been executed
Total: The total counts that the mark command should be executed. The value would

decrease 1 automatically after the mark command has been executed each time. It is unavailable
under the mode of Continuous Marking. When in marking process, if the amount number is more
than 1, the marking operation will not stop until the marking number is 0.

Parameter: machine parameter
Key “F3” is the shortcut key of this function.

10.4 Machine Parameters

10.4.1 Field Parameter
See Figure 10-18
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Figure 10-18 Area Parameter

Field: the widest range for marking
Gavlo 1=x: the track of gavlo 1 uesd as the X axis
Gavlo 2=x: the track of gavlo 2 uesd as the X axis
Offset X: The offset distance on X direction of scanhead.
Offset Y: The offset distance on Y direction of scanhead.
Use the corrected file: Use the correction file generated by our CorFile.exe soft.
Negate: the opposite direction of the current gavlo

This item refers to the distortional correction coefficient, and the default
value is 1.0 (range from 0.875 – 1.125). If your design is as Figure 10-19 shows but the marked
work is Figure 10-20 or Figure 10-21, you will have to increase the coefficient on the X axis
direction for Figure 10-20 and lower the coefficient on the X axis direction for Figure 10-21.
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Figure 10-19 Your Design

Figure 10-20 Marked Work

Figure 10-21 Marked Work

This item indicates the parallelogram correction coefficient, and the default is 1.0 (range
from 0.875 – 1.125). If your design is as Figure 10-19 shows but the marked work is Figure 10-22,
you will have to adjust this parameter to correct it.

Figure 10-22 Marked Work

Scale: It refers to the flex percentage, and the default is 100%. This parameter will be
adjusted when the trim size marked is different from the setting size. If the trim size is smaller
than the designed one, users can raise this parameter; if the trim size is bigger than the designed
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one, users can lower this parameter.
Note: If there are some distortions with the Laser scanner (gavlo), users should firstly adjust

the distortions and then the flex percentage.

When setting scale, we may press the button ，and a dialog will pop up just like figure

10-23.

Figure 10-23 Set the scale

Goal mark size: the size set in the software.
Real mark size: the measured size of the object that have been marked on the workpiece.
The software will calculate the scale automatically according to these two values.
After mark Go to: The gavlo jump to the appointed position when finishing marking
password: after set the password ,we must input it can enter the Param Dialog Box.

10.4.2 Laser Control Parameter
See Figure 10-24:
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Figure 10-24 Laser Parameter

Laser type:
Co2: It indicates that current laser size is Co2 laser.
YAG: It indicates current laser size is YAG laser.
Fiber: It indicates that current laser size is fiber laser.
SPI_G3: It indicates that current laser size is SPI laser.
Note: this function only support USBLMC control card.

PWM:
Enable PWM signals: The PWM signal will be output from Control Card
Max. PWM freq: the max frequency of the PWM signals
Enable Tickle: Let the preionization signals active for some CO2 laser sources.
Pulse Width: the pulse width of the preionization signals
Pulse Period: the frequency of the preionization signals
Use Digital Q-switch driver: This function is for digital Q-switch. If check this function, the

output port 1 and 2 cannot apply in other purpose. This mode mainly design for Digital Q driver of
Guilin Xingchen

Q-switch Open when F.P.K End: If Checked, the Q-switch modulation signal will begin
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pulsing after the FPS delay has expired. Otherwise Q-switch pulsing begins at the end of the Start
TC delay and coincidentally with the beginning of the FPK signal.

First Pulse Killer ( F.P.K): the lasting time for the first pulse suppression
Pulse width reverse: Reverse the PWM signal. See figure 10-25

Figure 10-25 pulse width reverse

Enable Power Analog Output: Enable the control card to output analog signal which used
to control laser power.

Power Mapping: This is power emendation function, used to set the power percentages of
the customized and the corresponding one, as Figure 10-26 shows. If the customized power
percentage is not in the displays of the Power dialog box, the system will pick the linearity margin
values.

Enable Frequency Analog Output: Enable the control card to output analog signal which
used to control Q-Switch frequency

Frequency Mapping: This is frequency emendation function, used to set the frequency
percentages of the customized and the corresponding one, as Figure 10-27 shows.

Enable CO2 FPK: can wipe off the burn-in effect at the start.
Enable CO2 Pulse Mode: When selected, the point dist will appear in the parameter, and the

software will be calculated the scan speed according to the setting. The marking points will meet
the setting with this speed.
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Figure 10-26 Power Map Dialog Box Figure 10-27 Frequency Map Dialog Box

Enable Analog First Pulse Killer:
Max: Max voltage of analog FPK.
Min: Min voltage of analog FPK.
T1: Time that the FPK signal changes from Max voltage to Min voltage, or reverse.
T2: If the time gap between the laser off and laser on is less than T2, the FPK would not

output.

：The direction that the FPK changes.

About the T1 and T2 we can see figure 10-28：

Figure 10-28
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After selecting fiber, the type of fiber laser will appear in the right, for example, ipg, ipgm,
quantel, raycus, and the corresponding frequency range and MO delay will appear

Test laser
It is used to test whether laser is working normally or not. Hit “test laser” button presenting
dialog box shown in graph 10-29:

Figure 10-29 Test laser dialog box

Fill in the frequency, power, pulse width and laser on time and hit “Laser on”. After that
LASER open and it will close when reach the appointed time.

10.4.3 Port parameter
Equipment port parameter is shown in graph 10-30:
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Figure10-30 Port Parameter Dialog Box

Stop Marking Input Port: When in marking process, if the system detects there is a
corresponding input signal, the current marking operation will be ended, and prompt the users
with error information.
Out port for Laser power: The port can be used to control the laser power supply. If you set
this port, there is a ‘Power off’ button displayed on the marking bar, see the figure

Red light pointer I/O: The system will output High-level to the appointed output port when
guide light show.
Marking IO: The appointed port will output high level voltage (TTL Compatible) while in
marking.
Start Mark IO: In idle state, the software will start mark if detect the high level voltage from
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the appointed port
Pulse Mode: Checking this option means the soft receive the start signal as pulse mode,
otherwise it is as level mode.

10.4.4 Other

Figure 10-31 Other Parameter Dialog Box

Starting Mark Delay: The delay before marking.
Finish Mark Delay: The delay after marking
Max. Power Delay: The Max dealy when the laser power is changed from 0% to 100%

during marking. When the power’s range is changed less then 100% during marking, the time is
less proportional to the Max vaule. This function is suit for the laser power supply with slow
response speed. If the laser power supply’s response speed is very quick, this value may be 0 ms.

Max. Freq Delay: Same as max power delay
Show start mark dialog: Every time inquired whether mark it before the marking
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Enable execute mark start and stop command file: When the mark started and finishes
needs to execute a command file first.

After enabling this function, when the marking starts, the system will seek for the start.bat
document under the current software of contents automatically and executes it; After the marking
had ended the system will seek for the stop.bat document under the current software of contents
automatically and executes it.

The bat document format is simple, it can use the textual edit software (for example: The
notepad, tablet and so on the other software) to direct compilation. Bat is the pure ASCII code text
document, altogether has 3 orders.

1. The examination input port orders IN, for example IN2=1 expression system
examination input port 2, if IN2 is the high level downward carries out, otherwise has waited
for that IN2 turns high.
2. The establishment output port orders OUT, for example OUT4=1, the expression system
establishment output port 4 is the high levels.
3. The time delay orders DELAY, for example DELAY=1000, expression system time
delay 1000 milliseconds.
Auto reset mark count: after the mark stop, the software reset mark count automatic
Disable mark when reach total count: set the total count, when the amount reached, the

software will not continue mark.
User step mark mode: When the marking according to the establishment the Galvo smallest

distance movement, delay fixed time after each movement distance, this function mainly uses in
the strong laser power hitting the depth, the step delay is bigger, the laser marks in the pause
position deeply.

Enable analog current fpk: the time when the analog current is 0 before marking.

Fly Mark
Mark with working line simultaneously. Hit “fly mark” button presenting the dialog box shown in
graph 10-32.
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Figure 10-32 Fly mark set dialog box

Fly mark: choosing this item refers to enable “Fly mark” function.
Fly from right to left: Choosing this item indicates that stream line direction is from right to
left.
On-the-Fly continue mode: Choosing it indicates mark object is continuous one, namely, we
need to mark content on continuous object. (Such as: wire ,cable and so on).
Enable total part num: Selecting it indicates the mark “total number” set is effective.
Enable speed simulation: It indicates that using simulation hardware method produce linear
speed. It requires appointing speed.
Enable marking as placed: Selecting it indicates that software will mark content according to
its order in the list in turns. Otherwise, software will mark content according to its position in
working space from left to right.
Encoder Signal Reverse : the signals from encoder is reversed.
Fly encoder Offser: the position of marking is in front of actual.
Inport: choose port of flying signal for Board Version 2.2.6 or update.
Fly speed coefficient: The calculation formula is shown as follows:

Fly speed coefficient = perimeter of coder tachometer wheel / coder pulse per revolution;

Red Light Pointer:
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Enable show contour: When selected, the red light show the object frame, not the rectangle
been made from the max coordinate and the min coordinate of the object.

Red Light Pointer: Refers to guide light
Light Speed: the speed of guide light
Offset Pos X and Y: it is used to compensate the position error between guide light and the

laser beam.
Enable continue mark mode: enable this function, return the software surface, click

“Param” then the dialog box popup shown as following Figure，it will be appear after mark stop
every time, the Red Laser Pointing always exist.
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10.4.5 HardInfo

There are Board Type, Board Version, SN in the HardInfo.
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